Empower 3 FR3 System Administrator's Guide

Copyright notice

© 2002 - 2016 WATERS CORPORATION. PRINTED IN THE UNITED STATES OF AMERICA AND IN IRELAND. ALL RIGHTS RESERVED. THIS DOCUMENT OR PARTS THEREOF MAY NOT BE REPRODUCED IN ANY FORM WITHOUT THE WRITTEN PERMISSION OF THE PUBLISHER.

The information in this document is subject to change without notice and should not be construed as a commitment by Waters Corporation. Waters Corporation assumes no responsibility for any errors that may appear in this document. This document is believed to be complete and accurate at the time of publication. In no event shall Waters Corporation be liable for incidental or consequential damages in connection with, or arising from, its use. For the most recent revision of this document, consult the Waters Web site (waters.com).

Trademarks

ACQUITY, ACQUITY UPLC, Empower, MassLynx, UPLC, "THE SCIENCE OF WHAT'S POSSIBLE." , and Waters are registered trademarks of Waters Corporation.

Adobe, Acrobat, and Reader are registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Agilent is a trademark of Agilent Technologies, Inc.

Citrix and ICA are registered trademarks, and XenApp and Citrix Presentation Server are trademarks of Citrix in the United States and/or other countries.

Hitachi is a registered trademark of the Kabushiki Kaisha Hitachi Seisakusho Corporation.

Microsoft, Internet Explorer, Windows, and Windows Server are registered trademarks of Microsoft Corporation in the United States and/or other countries.

Red Hat is a registered trademark of Red Hat, Inc.

Shimadzu is a registered trademark of the Shimadzu Corporation.

iPad, iPhone, and Safari are trademarks of Apple Inc., registered in the U.S. and other countries.

Android and Chrome are trademarks of Google, Inc.
Waters’ Technical Communications organization invites you to report any errors that you encounter in this document or to suggest ideas for otherwise improving it. Help us better understand what you expect from our documentation so that we can continuously improve its accuracy and usability.

We seriously consider every customer comment we receive. You can reach us at tech_comm@waters.com.

Contacting Waters

Contact Waters® with enhancement requests or technical questions regarding the use, transportation, removal, or disposal of any Waters product. You can reach us via the Internet, telephone, or conventional mail.

Waters contact information:

<table>
<thead>
<tr>
<th>Method</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet</td>
<td>The Waters Web site includes contact information for Waters locations worldwide. Visit <a href="http://www.waters.com">www.waters.com</a></td>
</tr>
<tr>
<td>Telephone and fax</td>
<td>From the USA or Canada, phone 800 252-4752, or fax 508 872 1990. For other locations worldwide, phone and fax numbers appear in the Waters Web site.</td>
</tr>
</tbody>
</table>
| Conventional mail  | Waters Corporation  
34 Maple Street  
Milford, MA 01757  
USA                                                                  |
# Table of Contents

**Empower 3 FR3 System Administrator's Guide** .............................................. iii
  Copyright notice ................................................................................................. iii
  Trademarks ........................................................................................................ iii
  Customer comments ............................................................................................ iv
  Contacting Waters ............................................................................................... iv

**Table of Contents** ............................................................................................ v

## 1 Introduction .................................................................................................. 9
  1.1 System overview ............................................................................................ 9
  1.2 Software description ...................................................................................... 11
    1.2.1 Server software ..................................................................................... 11
    1.2.2 Client software ...................................................................................... 12
  1.3 System administration .................................................................................. 12
    1.3.1 System administrator qualifications ....................................................... 13
    1.3.2 System administration tasks ................................................................... 13
    1.3.3 System administrator's log ....................................................................... 15

## 2 Managing the server ................................................................................... 17
  2.1 Network considerations ................................................................................ 17
    2.1.1 Synchronizing Empower and Windows Clock Time ............................. 18
  2.2 Windows user accounts .............................................................................. 19
    2.2.1 Windows administrator account privileges ......................................... 19
    2.2.2 Windows domain user account privileges ............................................ 19
  2.3 Managing the server disk space ................................................................. 20
    2.3.1 Checking free disk space ..................................................................... 20
    2.3.2 Increasing free disk space .................................................................... 20
    2.3.3 Defragmenting the hard disk ................................................................. 21
3 Managing the Empower 3 FR3 database .................................................. 23
  3.1 Waters database manager ........................................................................ 23
  3.2 Starting and exiting Waters Database Manager ....................................... 23
  3.3 Database file organization ....................................................................... 24
      3.3.1 Server configurations ...................................................................... 24
      3.3.2 Database file organization ............................................................. 24
  3.4 Configuring the Windows DBA account .................................................. 27
      3.4.1 Adding a user or group to the ORA_DBA group .......................... 27
      3.4.2 Granting the Windows DBA user batch job privileges .................. 28
      3.4.3 Stopping and starting the Oracle service ....................................... 28
  3.5 Manage Database User Accounts ........................................................... 29
      3.5.1 Locking and unlocking Oracle accounts ......................................... 29
      3.5.2 Changing Oracle account passwords ........................................... 30
      3.5.3 Reset the Sys account password ..................................................... 30
  3.6 Record database information .................................................................. 31
  3.7 Adding tablespace datafiles to the database ......................................... 31
  3.8 Archiving alert logs ................................................................................ 32
  3.9 Shutting down and starting up the Empower 3 FR3 database .................. 32

4 Managing Empower 3 FR3 software ............................................................ 33
  4.1 Using the TNS_Admin environment variable ......................................... 33
      4.1.1 Modifying the local security policy configuration on Windows Servers ................................................................................................. 33
      4.1.2 Configuring a shared tnsnames.ora file ......................................... 34
  4.2 Configuring a database net service name ................................................. 34
  4.3 Logging in to Empower as the default administrator ................................. 36
      4.3.1 Changing the Empower 3 FR3 system user account password .......... 37
      4.3.2 Changing the Empower 3 FR3 database password ........................ 37
  4.4 Managing raw data files .......................................................................... 37
      4.4.1 Adding a raw data share ................................................................... 38
      4.4.2 Moving project raw data files ........................................................... 38
      4.4.3 Viewing the current raw data paths ................................................ 39
  4.5 Using the System Monitor ....................................................................... 39
  4.6 Checking for Empower service or feature releases .................................. 40
5 Database backup and recovery ............................................. 41

5.1 Backing up the Empower 3 FR3 database .................................. 41
  5.1.1 Backing up Empower 3 FR3 database using scripts ................. 42
  5.1.2 Performing a database backup using a script ......................... 46
  5.1.3 Manually capturing a current-state backup .......................... 47
  5.1.4 Using Windows Scheduler to schedule database backups .......... 49
  5.1.5 Testing backups .................................................... 50

5.2 Recovering from a drive failure ........................................... 50
  5.2.1 Recovering from database drive failure using a cold backup ...... 51
  5.2.2 Recovering from an Empower software raw data drive failure .... 52
  5.2.3 Recovering from an Empower program files disk failure .......... 53
  5.2.4 Recovering from a database and raw data drive failure .......... 55

5.3 Restoring the Empower 3 FR3 database ................................ 55
  5.3.1 Recovering the last known good cold database backup ............ 55

6 Troubleshooting ..................................................................... 59

6.1 Additional help ..................................................................... 59

6.2 Isolating problems ............................................................... 59

6.3 Reporting problems ............................................................. 60

6.4 Buffering and data recovery problems .................................... 61
  6.4.1 Reconnecting while buffering ........................................... 61
  6.4.2 Continuing acquisition while buffering ............................... 62

6.5 Disconnect dead connections ................................................ 62

6.6 Software problems .............................................................. 63
  6.6.1 ACQUITY UPLC problems ............................................. 65

6.7 Hardware problems .............................................................. 66

6.8 Troubleshooting procedures .................................................. 71
  6.8.1 Evaluating Windows error messages ................................. 71
  6.8.2 Evaluating Empower 3 FR3 software error messages ............. 72

A Log forms ............................................................................. 73

A.1 Database initialization parameters ........................................... 73

A.2 Database storage information (Control files) ............................ 74
A.3 Database storage information (Tablespace) ........................................... 74
A.4 Data file information .............................................................................. 74
A.5 Data file information (Redo_logs) ............................................................. 75
A.6 Disk space usage log ................................................................................. 75
A.7 Database backup log .................................................................................. 76
A.8 Full disk backup log .................................................................................. 77
A.9 System service log ..................................................................................... 77
A.10 System problem log .................................................................................. 78
A.11 Hardware service information sheet ......................................................... 79
A.12 Software service information sheet ........................................................... 79
1 Introduction

This guide is intended for use by administrators of both the Waters® Empower® 3 Feature Release 3 (FR3) Enterprise client/server system and the Empower 3 FR3 Workgroup configuration. References in this guide to an Enterprise server also pertain to a Workgroup server. References to an Enterprise client also pertain to a Workgroup client.

This guide describes the hardware and software requirements, system administrative tasks, and security settings and policies for the server.

For information on how to back up and restore the Empower 3 FR3 database on an Empower Personal system, refer to "Backing up the Empower Personal database" and "Restoring the Empower Personal database" topics in the Empower Online Help.

1.1 System overview

The Empower 3 FR3 Enterprise client/server system and Workgroup configuration are networked versions of the Empower 3 FR3 Personal standalone workstation. The architecture of these systems consists of these parts, as shown in the following figure:

- A central database on the server
- Distributed acquisition
- Distributed processing

You can use an Empower Personal workstation as a client in a workgroup or enterprise environment.
Example of Empower 3 FR3 Enterprise and Workgroup system architecture:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Empower server that contains the Empower database and raw data files (Waters Service)</td>
</tr>
<tr>
<td>2</td>
<td>Alternate raw data storage that contains raw data files (Waters Service)</td>
</tr>
<tr>
<td>3</td>
<td>UPLC</td>
</tr>
</tbody>
</table>
### 1.2 Software description

This section describes the software components required to implement the Empower 3 FR3 Enterprise or Workgroup systems.

#### 1.2.1 Server software

The server software comprises these components:

- **Operating system**
  - Microsoft® Windows® Server 2008 R2 Service Pack 1 (SP1) 64-bit, Enterprise or Standard Editions or Windows Server 2012 R2 64-bit Standard Edition
  - Solaris 10
  - RedHat Enterprise Linux 6.2
- **Oracle® Enterprise Edition**
  - Version 11.2.0.4 for Windows
  - Version 11.2.0.4 for Solaris and RedHat
- **Empower 3 FR3 Enterprise or Workgroup software**

#### Windows Server operating systems

The Windows Server operating systems provide built-in networking utilities, protocol handlers, and services including basic file and print services and client/server application functionality.

#### Oracle Enterprise Edition 11g server

The Empower 3 relational database resides on the server in an Empower 3 Enterprise client/server system or an Empower 3 Workgroup configuration. Information from projects, such as processed results, sample identifiers, and methods, is stored in the Empower 3 database. The raw data files are not stored in the database. The raw data files are stored on the same server disk drive or on a different one.

Oracle client software provides the Empower 3 FR3 application running on the client computer with access to the Empower 3 database.
1.2.2 Client software

The client software runs on the PC and communicates with the corresponding software components on the server, as applicable. The client software includes these items:

- Windows 7 SP1, 64-bit Enterprise or Professional Edition, or Windows 8.1 64-bit, Enterprise or Professional Edition
- Empower 3 FR3 Enterprise or Empower 3 FR3 Workgroup client software
- Oracle Client Software version 11.2.0.4
- Internet Explorer® version 10 or 11

1.2.2.1 Windows 7 SP1 64-bit Enterprise or Professional Edition or Windows 8.1 64-bit, Enterprise or Professional Edition

The client’s Windows 7 SP1 or Windows 8.1 operating system provides the connectivity software that communicates with the server through TCP/IP. The Windows operating system, combined with TCP/IP services, provides the Empower 3 FR3 software with access to these components:

- Raw data files on the server or other computer on the network
- Network printers
- Empower 3 FR3 clients and LAC/E<sup>32</sup> acquisition servers

See also: Refer to the release notes for your LAC/E<sup>32</sup> acquisition server to determine which operating system is supported.

1.2.2.2 Empower 3 FR3 Enterprise or Workgroup client software

Empower 3 FR3 software allows you to acquire data and control chromatographic instrumentation, process data interactively or in the background, customize management of project information, and customize report design and generation.

1.2.2.3 Oracle client software

Oracle client software provides Empower 3 FR3 software with access to the Empower database through TCP/IP.

1.3 System administration

Managing the Empower 3 FR3 Enterprise or Workgroup system involves maintaining all the hardware components, operating system software, networking software, and application programs that make up the Empower 3 FR3 software. It also requires system administrators to know the system’s workload so that they can anticipate changes, problems, and growth.
1.3.1 System administrator qualifications

System administrators are responsible for the smooth and efficient daily operation of the Empower system. They control and maintain the system by performing the system administration tasks listed in “System administration tasks”.

To effectively administer the Empower 3 FR3 system, administrators must be familiar with the operation of the hardware and software listed in the following tables.

**Hardware:**

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server computer and peripherals</td>
<td>Server documentation</td>
</tr>
<tr>
<td>Waters LAC/E³₂ Acquisition Server</td>
<td>Empower 3 Installation, Configuration and Upgrade Guide (latest version)</td>
</tr>
<tr>
<td>Empower 3 FR3 clients</td>
<td>Empower 3 Installation, Configuration and Upgrade Guide (latest version)</td>
</tr>
<tr>
<td></td>
<td>and the Empower 3 Feature Release 3 online Help</td>
</tr>
<tr>
<td>PCs and printers</td>
<td>PC and printer manufacturer’s documentation</td>
</tr>
</tbody>
</table>

**Software:**

<table>
<thead>
<tr>
<th>Software</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empower 3 FR3 software</td>
<td>Empower 3 Installation, Configuration and Upgrade Guide (latest version)</td>
</tr>
<tr>
<td></td>
<td>and the Empower 3 Feature Release 3 online Help</td>
</tr>
<tr>
<td>Windows 7 SP1 or 8.1, Professional or Enterprise Edition, 64-bit</td>
<td>Microsoft Windows documentation</td>
</tr>
<tr>
<td>Windows Server 2008 R2 Standard or Enterprise with Service Pack 1, 64-bit or Windows Server 2012 R2 Standard Edition 64-bit</td>
<td>Microsoft Windows documentation</td>
</tr>
<tr>
<td>Oracle 11.2.0.4</td>
<td>Oracle 11g Server online documentation</td>
</tr>
<tr>
<td>Microsoft TCP/IP</td>
<td>Microsoft Windows Help</td>
</tr>
</tbody>
</table>

1.3.2 System administration tasks

This section describes the routine and periodic system administration tasks that administrators need to perform to keep the Empower 3 FR3 system running efficiently. Several tools can assist with these tasks:

- Empower 3 FR3 Online Help
- Empower 3 FR3 Configuration Manager
- Waters Database Manager

1.3.2.1 Routine tasks

Routine system administration tasks are those that you should perform regularly: once daily, once each shift (every 8 hours), or once a week. Routine system administration tasks apply to both the server and the client.

Periodic system administration tasks apply to both the server and the client.

1.3.2.2 Tasks performed from the Empower 3 FR3 server

The following table lists typical server tasks and chapter references.

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
<th>Recommended frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checking disk space and status</td>
<td>Empower 3 FR3 online Help</td>
<td>Daily</td>
</tr>
<tr>
<td>Backing up the Empower database</td>
<td>Empower 3 FR3 online Help</td>
<td>Weekly cold backups with daily hot backups</td>
</tr>
<tr>
<td>Deleting or archiving unneeded files</td>
<td>Empower 3 FR3 online Help</td>
<td>As needed</td>
</tr>
<tr>
<td>Archive alert log</td>
<td>Empower 3 FR3 online Help</td>
<td>Quarterly</td>
</tr>
<tr>
<td>Managing raw data files</td>
<td>Empower 3 FR3 online Help</td>
<td>As needed</td>
</tr>
</tbody>
</table>

1.3.2.3 Tasks performed from an Empower 3 FR3 client

You initiate periodic and routine client tasks from the Empower Configuration Manager on the client PC. The following table lists typical routine tasks that apply to clients.

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
<th>Recommended frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing up, restoring, and deleting projects</td>
<td>Empower 3 FR3 online Help</td>
<td>As needed</td>
</tr>
<tr>
<td>Managing user types</td>
<td>Empower 3 FR3 online Help</td>
<td>As needed</td>
</tr>
<tr>
<td>Task</td>
<td>Reference</td>
<td>Recommended frequency</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Managing users</td>
<td>Empower 3 FR3 online Help</td>
<td>As needed</td>
</tr>
<tr>
<td>Managing groups</td>
<td>Empower 3 FR3 online Help</td>
<td>As needed</td>
</tr>
</tbody>
</table>

### 1.3.3 System administrator's log

Set up and maintain a system administrator’s log to record all system administration tasks. Keep the log next to the system to record system administration information, such as the amount of free disk space or the date of the last backup. Also, keep a record of any problems you encounter with the system, as well as their resolution. See Appendix A for sample log forms.
Managing the server

2.1 Network considerations

The Empower Enterprise/Workgroup system requires a domain-based network infrastructure. You must synchronize Empower-related computers (clients, LAC/E32 modules, and servers) with a time server.

In domains based on Windows Server 2008 R2 Enterprise and Windows Server 2012 R2, the domain controllers are automatically configured to act as time servers for the domain.

To maximize service time and minimize issues related to the network environment, Waters recommends you follow these requirements:

- All Empower-related user accounts and computers must reside within the same domain.
- If you are using real-time virus scanning, after installation, exclude all Empower-related directories and their sub-directories, and all raw data directories or shares, from the scans. Some real-time virus scanners mistake normal Empower operations for virus activity and can therefore interfere with data buffering or cause the run to stop.
- After you install Empower software, do not change the IP name or address on the Enterprise server or the Personal workstation. The IP name should not contain more than 15 characters, dashes, or symbols. If you are using DHCP instead of a static IP, ensure that the IP name or address remains the same.

**Requirement:** The server name must begin with an alphabetic character (A to Z) and cannot begin with a numeric character (0 to 9). Empower123 is acceptable for a server name, but not 123Empower.

- Configure preferences in Waters Database Manager to notify you by email when tablespaces reach a user-defined size. Doing so helps you monitor database space usage. See the Waters Database Manager Online Help or "Adding tablespace datafiles to the database" on page 31 in this document for more information.
- When you add a server, LAC/E32 module, or client to a domain, ensure that the Window’s network discovery functionality is turned on for these computers.

**Notice:** If you are backing up a drive or directory that contains Empower software, ensure the Empower database is shut down. If you don’t shut down the database, the backup procedure causes the Empower database to disconnect and results in a database failure.
2.1.1 Synchronizing Empower and Windows Clock Time

Synchronize the Waters Empower time and the clock time on the host Windows operating system to avoid any discrepancy, which typically can be one hour.

To Synchronize Empower and Windows clock time:

1. Click Start > Control Panel > Clock, Language, and Region > Date and Time.

   Tips:
   - To access the Control Panel in Windows 8.1 and Windows Server 2012, right-click the Windows icon, and click Control Panel.
   - In Windows 8.1, the Windows Icon displays when you position the cursor in the bottom-left corner of the screen.

2. In the Date and Time tab, click Change time zone.

3. If you are prompted for an administrator password or confirmation, type the password or provide confirmation.

4. In Time Zone Settings, select the check box “Automatically adjust clock for daylight saving time”, and click OK in each open dialog box.

2.1.1.1 Group Policy Objects

System administrators use Group Policy Objects (GPOs) to define and enforce settings in an Active Directory network. Administrators can apply settings to users and computers based on locally defined group and site membership criteria. Before defining GPOs in an Empower network, keep in mind that Empower software is a distributed chromatography data acquisition system that relies on remote access and the Distributed Component Object Model (DCOM) configuration to carry out its activities. Empower software makes use of information stored in the database and in individual flat files, such as instsrv.dat (instrument configuration information) and channel_id.dat (raw data files).

If GPOs are used in an Empower network, Waters recommends that you follow these guidelines:

- Place Empower nodes in their own Organization Unit (OU). For the OU, define GPOs that minimize allowable changes: for example, test Microsoft hot fixes and service packs before applying them to the environment.
- Grant administrators full access to the registry and file system so that they can properly install software.
- Limit changes to the file system protections expected by the Empower application.

GPOs can interfere with successful Empower operations. For example, data buffering can occur if the anonymous access to the raw data share is altered, or the editors for the COM instruments can sometimes operate improperly if the access control list for the HTML directories is altered.
2.2 Windows user accounts

Windows user accounts allow access to various system functions. These user accounts can be local or domain. Local user accounts are created in the user management utility of the computer and cannot be used to log in to other computers. Domain user accounts are created in the user management utility of the domain controller. By default, domain users can log in to any computer that is a member of the same, or a trusted, domain.

These accounts permit access to the Windows operating system:

- Administrator accounts (local or domain)
- User accounts (local or domain)

Use an administrator account to log in to the Empower 3 FR3 Enterprise/Workgroup server when you need to perform system administration tasks.

2.2.1 Windows administrator account privileges

The Windows Server 2008 R2 or the Windows Server 2012 R2 Administrator account includes all privileges on the server. With administrator account privileges, you have full access to these files and directories:

- all public, personal, and system files and directories.
- Empower 3 FR3 database files.
- Empower 3 FR3 raw data files.
- all Windows Server 2008 R2 or Windows Server 2012 R2 user accounts and account information on the local machine.

For more information on Windows Server 2008 R2 or Windows Server 2012 R2 server privileges, see the Microsoft Windows Help and user documentation.

**Notice:** Use caution when you access the Windows Server 2008 R2 or Windows Server 2012 R2 server using an administrator account. This account allows you unlimited access to the Empower 3 FR3 software and Windows files and directories on the server.

2.2.2 Windows domain user account privileges

Use domain user accounts to log in to the operating system of Empower 3 FR3 clients. By default, domain users have limited access to local resources. After you install Empower 3 FR3 software on the client, domain users have full control of Empower 3 FR3–related program files. If you modify these permissions, users may not be able to perform normal Empower 3 FR3 software functions, such as creating or modifying instrument methods or viewing data in Review.
2.3 Managing the server disk space

The operating system disk management Properties dialog box provides several tools to help manage disk space. This section covers the following topics:

- Checking the amount of free disk space
- Increasing free disk space
- Defragmenting the hard disk

2.3.1 Checking free disk space

To avoid hard disk problems, and to maintain server performance, limit server hard drive use to no more than 80% of full capacity. The Windows operating systems provide utilities such as Windows Explorer, System Tools, Disk Management, and the Windows Help to help you manage server disk space.

Use the following procedure to check the amount of free disk space on the server. In a standard configuration, disk space on the server is used mainly by raw data acquired with Empower 3 FR3 software. The size of raw data files created in Empower 3 FR3 software is related to the sampling rate and the run time used to collect data. The database size also expands with usage. For instance, the archived redo logs generated by database activity grow over time, until they are cleaned up during hot and cold backups.

In Empower 3 FR3 software, you can define multiple raw data paths. Before doing so, check disk space on each drive where raw data files will be stored.

See also: Managing raw data files for more information.

Requirement: To avoid degradation in system performance, system administrators must check available disk space regularly. On systems with heavy daily usage, check and record available disk space frequently. If your system is used less frequently, check and record disk space accordingly.

To check free disk space on the server:

1. On the desktop, right-click Computer and then select Manage.
2. In the Server Manager window, click Storage > Disk Management.
3. Right-click a drive letter, and then select Properties to verify that there is available disk space.

Tip: There are also utilities available to monitor and alarm or send an e-mail when disk space reaches a user-defined size.

2.3.2 Increasing free disk space

You can increase free disk space the following ways:

- Archiving projects
- Adding a hard disk
• Moving project raw data to another file share, on a separate drive or server

2.3.2.1 Archiving projects

Archiving projects involves backing up projects, and then deleting the projects from the database. For details, see the procedures on archiving projects in the Empower 3 FR3 online Help.

Waters offers several automated archive options for Empower 3 FR3 software. For more information, contact your local subsidiary or see www.Waters.com.

2.3.2.2 Adding a hard disk

Another way to increase free disk space is to add a hard disk to your Empower 3 FR3 system. For more information see the hardware documentation and the Windows documentation that accompany your server.

2.3.2.3 Moving project raw data

Moving your raw data storage location to another computer or drive on your network adds additional storage capacity.

See also: Managing raw data files for more information.

2.3.3 Defragmenting the hard disk

Hard disk fragmentation occurs when you delete files from a disk and then create or add new files on the same disk. Therefore, fragmentation inevitably occurs with system use. If left unchecked, disk fragmentation can slow system performance markedly. The Windows operating system contains a defragmenting utility.

To access the Disk Defragmenter utility:

• On Windows 7 SP1 and Windows Server 2008 R2 SP1 Enterprise systems, click Start, type "Disk Defragmenter" in the Search box, then select it from the search results.
• On Windows 8.1, from Start, click the Search icon, type "Disk Defragmenter" and click the app in the results.
• On Windows Server 2012, from Start, click Server Manager > Tools > Defragment and Optimize Drives.

For information on using the Disk Defragmenter utility, see the operating system Help.
3 Managing the Empower 3 FR3 database

This chapter explains how to use the Waters Database Manager to manage the Empower 3 FR3 database.

These are the management tasks covered in this chapter:

- Waters Database Manager
- Starting and exiting Waters Database Manager
- Database file organization
- Configuring the Windows DBA account
- Manage Database User Accounts
- Record database information
- Adding tablespace datafiles to the database
- Archiving alert logs
- Shutting down and starting up the Empower 3 FR3 database

3.1 Waters database manager

You manage the Empower 3 FR3 database using the Waters Database Manager (WDM) Web application to monitor database backups and storage.

Notice: To avoid compromising the functionality of Empower 3 FR3 software, requiring its revalidation, do not perform additional database tuning. Contact your Waters data specialist before implementing any database changes.

3.2 Starting and exiting Waters Database Manager

When starting Waters Database Manager for the first time, you must enter a valid user name and password. An administrator creates a user account for you, and if it has administrator (ADMIN) privileges, you can change your password at any time. Otherwise, you must ask an administrator to change it for you.

You can log on to WDM using these browsers:

- Internet Explorer® 11 or later without Compatibility mode
- Google Chrome™ 35 or later
- Safari for iPad iOS 7.1

Recommendation: Google Chrome 35 or later
To start Waters Database Manager:

1. Use one of the following methods to start Waters Database Manager:
   - From an Empower 3 FR3 application/database server, click Start > Empower > Waters Database Manager.
   - From a supported browser, enter the web url http://<computer name>:8181/ords/f?p=Waters into the address bar, substituting the computer name for the application/database server.

2. When the Waters Database Manager Login screen appears, enter a valid user name and password, and the click Login.

   Tip: The default login user name\password is "administrator\administrator".

Result: The dashboard appears, providing several options for managing the database.

The maximum idle time for a session is 10 minutes. You can, however, log on to the Waters Database Manager application as often as necessary. To view default settings, click Server > Profiles.

To exit from the Waters Database Manager application:

1. While logged in to the dashboard, click the down arrow next to your user ID in the upper right-hand corner of the dashboard.
2. Click Sign Out.

3.3 Database file organization

This section describes the organization of the Empower 3 FR3 server and discusses server hard drives and database file organization.

3.3.1 Server configurations

The default configuration of the Empower 3 FR3 server uses four large-capacity hard drives partitioned into four logical drives for storing these items:

- Empower 3 FR3 application program files
- Empower 3 FR3 database data files
- Empower 3 FR3 projects including raw data files
- Empower 3 FR3 Oracle database files

3.3.2 Database file organization

For detailed information on defining the basic database structure, see the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide. The spfile and other parameters used during instance creation define the Empower 3 FR3 database. For performance and reliability reasons, the Oracle archive logs, mirrored control files, and mirrored redo logs are usually located on different physical disks. These locations are defined when Empower 3 FR3 software is installed.
**Tip:** The location of your Empower 3 FR3 database files depends on the locations you selected when you installed the database.

For detailed information on the Oracle database files, see the *Oracle Database Concepts* manual for version 11g and the latest version of the *Empower 3 Installation, Configuration, and Upgrade Guide*.

The Empower 3 FR3 database files are organized by default as shown in the following table. The specified locations assume a standard installation of Empower Enterprise to the recommended locations on a server with four physical drives. The file names and locations further assume that the default SID (WAT11) was selected during installation; if not, replace all occurrences of WAT11 in the table with your SID.

**Empower 3 FR3 application program and mirrored files:**

<table>
<thead>
<tr>
<th>Drives</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>[program-drive]\Empower\Bin</td>
<td>The Empower software executable files.</td>
</tr>
<tr>
<td>[program-drive]\Empower\Script</td>
<td>The Empower 3 FR3 software scripts, including the hot and cold backup script files.</td>
</tr>
<tr>
<td>\WatersCDSArchive2DB</td>
<td>One set of mirrored archive logs used for database recovery.</td>
</tr>
<tr>
<td>\WatersCDSArchive1DB</td>
<td>Set of mirrored archive logs.</td>
</tr>
<tr>
<td>\WatersCDSMirrorDB\oradata\WAT11</td>
<td>Control\0n.ctl – Mirrored copies of the database control files (where n equals 2 to 3). Redo\0n.rdo – Mirrored copies of the redo logs (where n equals 1 to 4).</td>
</tr>
</tbody>
</table>

**Empower 3 FR3 Projects including raw data files:**

<table>
<thead>
<tr>
<th>Drives</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>rawdata-drive:\Empower\Projects</td>
<td>This directory is the default raw data location. It contains a subdirectory for each project in the database. <strong>Tip:</strong> The project folder names viewed in this directory do not always exactly match the project names displayed in Configuration Manager when projects are part of a project hierarchy or when projects have been renamed.</td>
</tr>
</tbody>
</table>

**Empower 3 FR3 Oracle files:**

[Oracle drive] is the drive where you have installed the Oracle software.
<table>
<thead>
<tr>
<th>Drives</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Oracle drive]:\Empower\Oracle\diag\rdbms\WAT11\WAT11\Trace</td>
<td>The Oracle alert log, which contains information regarding database activity.</td>
</tr>
<tr>
<td>[Oracle drive]:\Empower\Oracle\Oracle11g_4\Bin</td>
<td>The Oracle software executable files.</td>
</tr>
<tr>
<td>[Oracle drive]:\Empower\Oracle\Oracle11g_4\Database</td>
<td>pwdWAT11.ora file – The Oracle (not Empower) password. SPFILEWAT11.ora – The server parameter file. <strong>Restriction:</strong> Do not edit the password or SpfileWAT11.ora file.</td>
</tr>
<tr>
<td>[Oracle drive]:\Empower\Oracle\Oracle11gClient_4\Network\Admin</td>
<td>tnsnames.ora – The connect information for the Empower 3 FR3 database.</td>
</tr>
<tr>
<td>[Oracle drive]:\Empower\Oracle\diag\tnslsnr\server name\listener\trace</td>
<td>Listener.log – Information about database connections.</td>
</tr>
<tr>
<td>rawdata-drive:\WatersCDSMirrorDB\oradata\WAT11</td>
<td>Control0n.ctl – Mirrored copies of the database control files (where n equals 2 to 3). Redo2n.rdo – Mirrored copies of the redo logs (where n equals 1 to 4).</td>
</tr>
</tbody>
</table>
Empower 3 FR3 Database files:

<table>
<thead>
<tr>
<th>Drives</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>database-drive:\EmpowerDatabase\oradata\WAT11</td>
<td>INDEX0n.DBF – The index tablespace data files (where n is 1 to 9).</td>
</tr>
<tr>
<td></td>
<td>TEMP01.DBF – The temporary tablespace data file.</td>
</tr>
<tr>
<td></td>
<td>SYSTEM01.DBF – The system tablespace data file.</td>
</tr>
<tr>
<td></td>
<td>UndoTBS01.DBF – The undo tablespace data file.</td>
</tr>
<tr>
<td></td>
<td>SYSAUX01.DBF – The sys aux tablespace data file.</td>
</tr>
<tr>
<td></td>
<td>USERS0n.DBF – The user tablespace data files (where n is 1 to 9).</td>
</tr>
<tr>
<td></td>
<td>CONTROL01.CTL – One copy of the database control file.</td>
</tr>
<tr>
<td></td>
<td>REDO0N.rdo – The redo logs (where n is 1 to 4).</td>
</tr>
</tbody>
</table>

3.4 Configuring the Windows DBA account

The Windows user account must be added as a member of the ORA_DBA group. When the user is already a member of a domain group, such as Server Operators, the group can be added as a member of the ORA_DBA group. For Windows Server 2008 R2 servers, the local and domain administrators are automatically added as members of the ORA_DBA group. To give a different user (or group) ORA_DBA privileges, follow the procedure listed below.

3.4.1 Adding a user or group to the ORA_DBA group

To add a user or group to the ORA_DBA group, follow the procedure listed below.

To add a user group to the ORA_DBA group:

2. In the Computer Management window, browse to System Tools > Local Users and Groups > Groups.
3. In the right-hand pane, double-click ORA_DBA.
4. Click Add.
5. Take one of the following actions if the administrator account you will be using to manage the database is not already listed as a member, and then click OK:
   - In the Select Users, Computer, Service Accounts or Groups dialog box, click Locations. If you are adding a preconfigured local user to the group, select
the Empower 3 FR3 database server name. If you are adding a domain user or group, select the appropriate domain.

Requirement: To select a domain user or group, you must have access to the domain administrator username/password. If you want to select a user account on the local server, click Cancel when prompted for domain credentials, and then select the database server name from the Locations dialog box.

- In the Select Users, Computer, Service Accounts or Groups dialog box, enter the name for the user or group whose credentials will be used for database management functions, and then click OK.

3.4.2 Granting the Windows DBA user batch job privileges

To grant the Windows DBA user the privilege to log on as batch job:

1. Click Start > Administrative Tools > Local Security Policy.
2. Expand the Local Policies, click User Rights Assignments, scroll down the Policy list, and then double-click Log on as a batch job.
3. In the Local Security Setting dialog box, click Add User or Group.
4. In the Select Users, Computers, Service Accounts or Groups dialog box, click Locations.
5. If you are adding an existing local user to the group, select the name of the Empower 3 FR3 database server.
6. If you are adding a domain user or group, select the appropriate domain.

Requirement: To select a domain user or group, you must have access to the domain administrator username and password. To select a user account on the local server, click Cancel when prompted for domain credentials, and then select the database server name from the Locations dialog box.

7. Click OK.
8. Enter the name for the user or group whose credentials will be used for database management functions, and then click OK.
9. Click OK.

3.4.3 Stopping and starting the Oracle service

Before stopping the Oracle service, use System Monitor to confirm that no users are currently connected to the Empower 3 FR3 database. To start System Monitor, log in to Empower 3 FR3 software and select View > System Monitor from the Configuration Manager window.

To stop the Oracle service:

1. Click Start > Administrative Tools > Computer Management.
2. In the Computer Manager window, expand Services and Applications, and then click Services Properties.
3. In the list of services, right-click OracleServiceWATn, where n varies with the database version (Empower 3 FR 3 is WAT11), and then select Properties.

4. Click Stop.

5. If the service does not stop, or if you want to ensure that the database does not attempt to start automatically when the server is restarted, change the Startup Type to Disabled, and then restart the server.

   **Requirement:** When you are finished maintaining the database or server, you must reset the Startup Type of the OracleServiceWATn to Automatic.

**To start the Oracle service:**

1. Click Start > Administrative Tools > Computer Management.
2. In the Computer Manager window, expand Services and Applications, and then click Services.
3. In the list of services, right-click OracleServiceWATn, and then select Properties.
4. Click Start.

### 3.5 Manage Database User Accounts

Empower 3 FR3 software uses Oracle database user accounts, such as Sys and System, to manage the database.

**Recommendation:** Reset user account passwords for the Oracle database after you install Waters software and periodically thereafter, according to your organization’s security policies and standard operating procedures.

You can manage Oracle database user accounts by locking and unlocking them and resetting users’ passwords.

#### 3.5.1 Locking and unlocking Oracle accounts

It can be necessary to lock an Oracle account, to prevent its unauthorized use. It can also be necessary to unlock an Oracle account that was locked when an Oracle user exceeded the specified number of attempts when entering a password.

**To lock an Oracle database user account:**

1. Log on to the Waters Database Manager application and then, from the dashboard, click Manage Oracle Database Users.
2. From the Users page, select a user account, and click Edit .
3. From the Manage User page, click Lock User.

**Result:** The database user cannot use this account until it is unlocked.
To unlock the Oracle database user account:

1. Log on to the Waters Database Manager application and then, from the dashboard, click Manage Oracle Database Users.

2. From the Users page, select a user account, and click Edit.

3. From the Manage User page, click Unlock User.

Result: The database user can use this account.

3.5.2 Changing Oracle account passwords

You can change or reset Oracle account passwords anytime.

Recommendation: Change the Oracle user passwords after you install the software and periodically according to your organization's security policies and standard operating procedures.

To change a user's password:

1. Log in to the Waters Database Manager application, and then click Manage Oracle Database Users from the dashboard.

2. From the Users page, select a user account, and click Edit.

3. From the Manage User page, do as follows, and then click Re-set Password.
   - In the Password field, type a new password for the account.
   - In the Re-enter Password field, retype the password, and then click Reset.

3.5.3 Reset the Sys account password

When you reset the Oracle Sys account password, you must also change it in the Manage Application Configuration page. If you do not change the password on this page, you will not be able to run database scripts.

To change the Sys account password:

1. From the Waters Database Dashboard, click Application Admin, and then click Manage Application Configuration.

2. From the Application Configuration page, locate DMB Script User Password in the Parameter column, and then click Edit.

3. From the Configuration Parameter page, type the new Sys password in the Password field, type it again in the Confirm Password field, and then click Apply Changes.
3.6 Record database information

The database name and identification number is on the Waters Database Manager application dashboard in the Database Information group box. When you contact Waters Technical Support, you must provide that information.

As soon as your database is built, record the following information:

- Unique database name
- Database ID
- Whether the Archive log mode is turned on or off

To view the location of your Fast Recovery Area, click Manage Backups > Backup Settings. The Disk Backup Location lists the FRA location.

3.7 Adding tablespace datafiles to the database

You can add tablespace datafiles to the database to increase storage for a datafile. Typically you would need to add storage to the User_Data or the Index_Data files. You add tablespace datafiles by using Waters Database Manager.

To add a tablespace datafile to the database:

1. Log on to Waters Database Manager.
2. From the Dashboard, click Server.
3. From the Server page, click Tablespaces (beneath Storage).
4. From the Tablespaces page, select the manage datafiles icon to identify into which tablespace to add the datafile.
5. From Manage Datafiles page, enter the following information:
   - In the Initial size field, enter the number of megabytes of the initial size of the datafile.
   - In the Maximum Size field, enter a number in megabytes to specify the maximum size of the datafile.
   - In the Increment By field, enter a number in megabytes that the datafile will be incremented by.
6. Click Add.

Recommendation: Contact Waters Technical Support for assistance before adjusting datafile storage.

To adjust the datafile size limit:

1. Log on to Waters Database Manager.
2. From the Storage pane on the Server page, click Datafiles.
3. Locate the datafile that you want to modify in the File Name column, then click the Adjust Storage Settings icon in the first column.

4. In the Adjust datafile storage settings page, change the storage settings as follows:
   - In the Increment By field, enter the number of megabytes that the storage space will be increased when the datafile reaches its initial limit.
   - In the Maximum Size field, enter a number in megabytes to specify the maximum size of the datafile.
   - In the Minimum Size field, enter a number in megabytes to specify the minimum size of the datafile, or remove the check from the Enable auto extension box and enter a Maximum Size in megabytes for the datafile.

5. Click apply.

3.8 Archiving alert logs

The Oracle alert log (Alert_WAT11.log) is a file that Oracle uses to log important database information. The file continually grows larger, and if it becomes too large, it can adversely affect system performance. Archive the alert log on a regular basis so that it does not become so large as to cause problems.

To archive the alert log, move it from program-drive:\Empower\Oracle\diag\rdbms\WAT11\WAT11\Trace to your storage location.

Tip: Once you move the alert log, a new one is recreated automatically.

3.9 Shutting down and starting up the Empower 3 FR3 database

The Empower 3 FR3 database is set to start when you power-on the database server. This section describes how to manually shut down and start up the database. Shutting down or starting up the database is a database management function that requires two sets of user credentials: a Windows DBA user (local or domain) who is a member of the local ORA_DBA group and an Oracle user with SYSDBA or SYSOPER privileges. The Windows DBA user must also be granted the privilege to log on to the server as a batch job.
Notice: If you are logged in to Empower 3 FR3 software and then you log out and leave some of its applications running (such as Configuration Manager), a Running Empower Applications message box appears. This message box reminds you that the applications remain open and offers the option of leaving them in a locked or unlocked state. If you leave them in an unlocked state, a user without the required access privileges can log in and use the open applications as if he or she were you, assuming your access privileges, regardless of whether his or her user type grants those privileges.

When performing administrative tasks on a client, use the Empower 3 FR3 Pro interface.

4.1 Using the TNS_Admin environment variable

The Empower 3 FR3 client and LAC/E32 acquisition server installer can create an environmental variable, TNS_ADMIN, the value for which is the path to the shared folder containing a preconfigured tnsnames.ora file. Using this variable on clients and LAC/E32 acquisition servers removes the requirement to manually configure and maintain individual tnsnames.ora files on each computer. If you use this feature, be sure to place the tnsnames.ora file in a share on a server that your users can access to log in to Empower 3 FR3 software.

Exception: If network connectivity fails while a LAC/E32 acquisition server is acquiring data, you must use a local tnsnames file, and then upload the sample set data to recover the interrupted data.

Recommendation: Locate the shared tnsnames.ora file in the \Empower\Projects directory, because that folder is shared with the appropriate security settings applied and must be available for normal Empower 3 FR3 software functionality.

4.1.1 Modifying the local security policy configuration on Windows Servers

The local security policy configuration is automatically set during the Empower 3 FR3 installation. If the TNS_ADMIN environmental variable is used to access an Empower 3 FR3 database on a Windows 2 servers, you must modify the default local security policy configuration on the database server to ensure proper Empower 3 FR3 software performance.
To modify the security policy configuration:

1. Log on to the Empower 3 FR3 database server as an administrator.
2. Select Start > Administrative Tools > Local Security Policy.
   
   Tip: In Windows Server 2012, from Start, click Server Manager > Tools menu > Local Security Policy.
3. In the left-hand tree, expand Local Policies, and then expand Security Options.
4. Double-click the policy “Network Access: Allow Everyone permissions to apply to Anonymous,” and then select Enabled.
5. Click Apply, and then click OK.

4.1.2 Configuring a shared tnsnames.ora file

You must configure the tnsnames.ora file before permissions are set on the raw data share. For information about setting permissions, see the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.

To configure a shared tnsnames.ora file:

1. Locate the drive installed with the Oracle program files, and browse to the Empower\Oracle\Oracle11gClient_4\Network\Admin directory.
2. Locate the tnsnames.ora file, right-click the file, and then click Copy.

   Requirement: If you have multiple Empower 3 FR3 Database servers, add them to the tnsnames.ora file using the Waters Net Configuration Assistant prior to copying the tnsnames.ora file. For information about using the Waters Net Configuration Assistant, see the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.

3. Browse to the raw data drive:\Empower\Projects directory, and paste the tnsnames.ora file into the folder.

   Recommendation: Place the share in the same directory that will hold Empower 3 FR3 raw data. If you use custom directories, set the share permissions exactly as described in the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.

4.2 Configuring a database net service name

You must configure a database net service name (previously called a database alias) on each client to connect to the Empower database, unless you are using the TNS_ADMIN environment variable. A database net service name is a name for an individual Empower database. This name appears in the Database field of the Empower Login page.
Tip: The TNS_ADMIN variable is set during installation, and a tnsnames.ora file is created. The TNS_ADMIN variable points to the tnsnames.ora file. A tnsnames.ora file contains the list of Empower databases that can be accessed by the client or LAC/E module.

Use the following procedure to create a new database net service name, or modify an existing net service name. If you are using an Empower Personal as a client, perform this procedure to force the use of the TNSNames.ora file. You must define the same database net service name on each client or LAC/E module.

To configure a database net service name:

1. Select Start > All Programs > Empower > Waters Net Configuration Assistant. 
   Alternative: Click Start, and type Waters Net Configuration Assistant.
   From an Empower Personal: Click [program drive]:\Empower\Bin\WatersNetConfig application.
   Tip: In Windows Server 2012, from Start > click the down arrow (▼) to display the Apps page > point to Empower > select Waters Net Configuration Assistant.
2. On the Waters Net Configuration Assistant utility, click the first row to edit the column details.
3. In the Alias column, type the alternative name for the database service.
   Example: WATWIN2008R2
   Rule: The database service identifier must begin with a character, not a number.
4. In the Server Name column, type the computer name or IP address of the database server.
5. In the Service Name column, type the database service name in this format: <SID.ServerName.domain>,
   where the SID is the Oracle Service Identifier, the ServerName is the value you entered in the Server Name column, and the domain refers to the domain of the server as well as the client or LAC/E machines.

Note:
- For Windows systems, the SID must start with “WAT” followed by alphanumeric characters up to 8 characters in length. This is not mandatory for databases installed on Redhat and Solaris systems.
- The default is “WAT11”.

Tips:
- If you do not know the Service name, you can find the name using the Listener Configuration on the database server. The Listener configuration is disabled on the client. Perform the check on the database server as follows: Click Configuration > Listener Configuration. The Waters Net Configuration Assistant displays the service name (Service = “<servicename.”).
- The global database name is the combination of the Oracle Service Identifier (SID) and the database domain name, as supplied during installation. For example, if the SID is WAT11 and the database domain name is
Empower1.Waters.com, the global database name is WAT11.Empower1.Waters.com.

6. In the Port Number column, ensure the default port selection is 1521.
7. Click Save.
   **Result:** The tnsnames.ora file is created.
8. Select the row, right-click, and then select Test.
9. In the Change Login dialog box, verify that the username “System” and password “empower” are prepopulated, and then click OK.
   **Tip:** “empower” is the default password for the Oracle System account in Empower 3. The password is not case-sensitive.
10. When the connection test is successful, click OK.
    **Result:** When you log on to Empower 3 FR3 from a client, the database alias name is automatically populated in the Login dialog box.

### 4.3 Logging in to Empower as the default administrator

Empower 3 FR3 software comes with a default system user account that does not require a named user license. This administrator account can be disabled but not deleted from Empower 3 FR3 software.

**To log in as the default system administrator:**

1. Select Start > All Programs > Empower > Empower.
   **Tip:** To Access Empower in Windows Server 2012, from Start, click the down arrow to display the Apps page > point to Empower, and click the Empower utility.
2. In the Empower Login dialog box, enter System as your user name and Manager as your password.
   **Tip:** The username and password are not case sensitive.
3. Select the net service name (database alias) for your Empower 3 FR3 server.
4. Click Advanced and verify that the Requested Interface field is set to Pro.
   **Requirement:** If you do not have access to the Pro interface, you must log in with a different user account or modify the user properties of the current user account. See the Empower 3 FR3 online Help for more information.
5. Click OK.
   **Result:** The Empower Pro window appears with the name of the database and the logged-in user displayed.
4.3.1 Changing the Empower 3 FR3 system user account password

Change the Empower 3 FR3 system user account password the first time you log in and regularly thereafter to maintain system security.

**Requirement:** You must be logged in as an Administrator to perform this procedure.

**To change the System account password:**
1. In Configuration Manager, select the Users view.
2. In the right-hand pane, select System.
3. Right-click System, and then select Properties.
4. In the General tab, enter the new password in the New Password and Confirm New Password boxes.
5. Click OK.

4.3.2 Changing the Empower 3 FR3 database password

The Empower 3 FR3 software uses the database password to access the database. Waters recommends that you do not change this password unless the security protocol of your organization requires this.

**Recommendation:** If your organization’s policy requires you to change this password, be certain to change it properly from the Configuration Manager window.

**Restriction:** Do not change this password directly in Oracle. Follow the procedure below exactly as it is written.

**To change the Empower 3 FR3 Oracle database password:**
1. Save any unsaved results.
2. Close all open applications except Configuration Manager and the Empower Pro window.
3. In Configuration Manager, select View > Database Properties.
4. In the Database Properties dialog box, click Change Database Password.
5. In the Change Password dialog box, enter the old password and the new password.
6. Confirm the new password by retyping it, and then click OK twice.

4.4 Managing raw data files

The Manage Raw Data Files capability allows you to configure additional paths on your system in which to store raw data on a per-project basis. By default, project raw data files are stored in the rawdata-drive:\Empower\Projects directory; however, you can specify any valid share on your network. The specified directory does not have to reside on an Empower 3 FR3 server, although the WatersService service must be
running on the computer where the path is located. For information on installing the WatersService service, see “Installing a File Server” in the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.

4.4.1 Adding a raw data share

To add a raw data share:

1. In Configuration Manager, select View > Manage Raw Data Files.
2. In the Manage Raw Data Files dialog box, select the name of the file service running on the computer on which you want to store your data from the File Service list.

   Tip: To add a file service, click Add File Service, enter the node name for the new file service, and then click OK.

3. Click Add Raw Data Share.
4. In the Add Raw Data Share dialog box, enter the share name and click OK.

   Result: If the share does not already exist, a dialog box appears, allowing you to specify the directory path for the share.

When the share is created, the default permissions are applied. The permissions vary depending on operating systems. To ensure proper functionality and security, the permissions on the raw data folder must be set exactly as described in the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.

When creating a new project, you can specify the raw data path in the Name Entry page of the New Project Wizard. You can also move existing project data to a different raw data share. The three Empower 3 FR3 software privileges associated with this capability are Create Project Path, Specify Project Path, and Change Project Path. Users must have the appropriate privilege to use the different aspects of this feature.

Exception: If a raw data path that is being used by a project(s) is removed, the path no longer appears on the list in the Manage Raw Data Files dialog box; however, the project’s existing and newly acquired data continue to use the removed raw data path.

4.4.2 Moving project raw data files

You can move project raw data to a new data directory. To do so, in Configuration Manager, right-click the project and select Move Project Data. For more information, see the Empower 3 FR3 online Help.

Recommendation: When moving large amounts of data, do not use the Move Project Data utility. Instead, modify the project’s raw path using Move Project Data and then manually move the files using operating system commands.
### 4.4.3 Viewing the current raw data paths

By default, the column listing the directories containing project raw data do not appear in the Configuration Manager Projects table. You can add this information to the table by creating a view filter.

**To display the current raw data paths for projects:**

1. Log in to Empower 3 FR3 software as an administrator user.
2. In Configuration Manager, click Projects.
3. To open the View Filter Editor, click Edit View.
4. Add Directory to the list of columns shown in the view Filter Editor.

   **Tip:** Ensure that the Name column is the first one in the list.

5. Save the view filter, and then exit the View Filter Editor.

   **Result:** The Directory box displays the current raw data paths for projects.

---

### 4.5 Using the System Monitor

The System Monitor application allows you to monitor system database usage. Information such as which users are accessing which projects, systems, and processing servers appears in table form. The following four views are available:

- Users
- Systems
- Projects
- Processing

System Monitor also displays the total number of licenses used compared to the total number of licenses available, by license type. The different license types are User Licenses, System Licenses, Agilent LC Licenses, Agilent GC Licenses, Shimadzu LC Licenses, Shimadzu GC Licenses, and Hitachi LC Licenses.

**Tip:** For each license type, the total number of available licenses is the total number of licenses that were activated during installation minus the total number of licenses used.

To access System Monitor, select View > System Monitor from the Configuration Manager window.

For more information on System Monitor, see the Empower 3 FR3 online Help.
4.6 Checking for Empower service or feature releases

Waters periodically issues service or feature releases to address existing issues or to provide enhanced functionality. These service releases are available for download from the Waters Elite Web site. Install them according to the instructions contained in their respective release notes. For those customers who require physical media, note the part number from the Web site and contact your local subsidiary to place an order.

**Tip:** You can find the Empower software build number and determine which service and feature releases are installed by clicking Help > About in any Empower software window.
5 Database backup and recovery

Recommendation: Periodically test your sets of backup media to ensure that the backups are working correctly and according to your organization’s standard protocols for failure recovery.

5.1 Backing up the Empower 3 FR3 database

To prevent the loss of data and maintain the archive log destination directories, run the backup scripts regularly. The best time to implement backup scripts is during system installation, as part of your disaster recovery plan.

To protect Empower 3 FR3 data, Waters recommends that you perform these tasks:

- A hot backup of the database and the Empower 3 FR3 software raw data files at least once a day.
- A cold backup of the database and the Empower 3 FR3 software raw data files at least once a week.

Recommendation: Determine the frequency of backing up based on the relative importance of your data. If you are working with critical data, consider backing up your files more than once a day, or backing up individual projects using the Empower 3 FR3 software backup tools.

For information about scheduling backups, see “Using Windows Scheduler to schedule database backups”.

There are two types of backup sets:

- A hot database backup set is created while the Empower Database is in backup mode. This backup mode refers to a process of placing the database in a state that allows the use of Oracle tools to copy the database files to another location without closing the database. When restoring this type of database backup, some manual database recovery efforts are usually required before these files can be used to open the restored database.
- A cold database backup set is created while the Empower database is closed. No new transactions can be placed against the database while it is closed. When restoring this type of database backup, manual recovery efforts are generally not required when these files are used to open the restored database.

Important: In the event of a system failure, manually capture a current backup before you attempt to repair the system.
5.1.1  Backing up Empower 3 FR3 database using scripts

This section describes the procedures for backing up the Empower 3 FR3 database using the backup script files provided by Waters.

When you install the Empower 3 FR3 database, hot and cold backup scripts are written to the program-drive:\Empower\Script directory. The scripts can be run manually from a command prompt or as a scheduled task. Both backup scripts move the accumulated archive logs from their default locations to the directories in the backup folder.

The backup scripts are dynamic and automatically query the database, each time a backup is run, to determine the current locations of all database data files, control files, archive logs, and Empower 3 FR3 raw data. This allows you to modify the Empower 3 FR3 environment, such as adding data files or raw data file locations without the need to manually revise the backup scripts.

5.1.1.1  Backup script files

The CS_Hot_Gen.bat and CS_Cold_Gen.bat scripts copy all Empower database files to a second location on a hard drive. The files contained within these backups (backup sets) represent the state of the database at a specific time. The backup sets sometimes include a copy of all the chromatographic raw data files, depending on the parameters selected for these scripts.

5.1.1.2  The backup set structure

The backup script (hot or cold drive backup) that you use to back up the Empower 3 FR3 database results in a specific backup set structure. When you restore the database from one of these backups, it is important to be familiar with the backup set structure.

A backup creates a backup folder with the following structure:

- Archive folder containing the archive (.arc) log files
- Backups script folder containing the backup script files
- Database folder containing the database files, the Oracle password file, the mirrored redo log files, and a subfolder containing the control files
- Projects folder containing the project raw data files (with each project in its own folder)

The cs_hot_gen.bat script backs up database files, control files, redo logs, archive log files, the spfile, the Oracle password file, and raw data files to a specified backup drive. It also backs up the spfile to a pfile. As part of the backup, the archive log files are moved from their default locations to directories within the backup. The database remains accessible to users while the backup is in process. If the script is rerun to the same location, the existing backup is deleted and replaced by the new backup.

The following table lists the folders and files that are created by the hot backup script.
cs_hot_gen.bat database backup script:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Sub-folder and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>archive</td>
<td>Log Archive Dest 1 and Log Archive Dest 2 contain the archive log files.</td>
</tr>
<tr>
<td>backupscript</td>
<td>Contains these files:</td>
</tr>
<tr>
<td></td>
<td>• Beginbackup.sql — Puts tablespaces in backup mode.</td>
</tr>
<tr>
<td></td>
<td>• EmpowerHBU.sql — Builds the EmpowerHBU.bat file.</td>
</tr>
<tr>
<td></td>
<td>• EmpowerHBU.bat — Copies the database files in the backup directory.</td>
</tr>
<tr>
<td></td>
<td>• ArcDir.sql — Creates the ArcDir.bat file.</td>
</tr>
<tr>
<td></td>
<td>• ArcDir.bat — Creates the archive directories in the backup directory.</td>
</tr>
<tr>
<td></td>
<td>• Arc.sql — Creates the Copy_Arc.bat file.</td>
</tr>
<tr>
<td></td>
<td>• Copy_Arc.bat — Backs up the archive logs before and after the database files are created.</td>
</tr>
<tr>
<td></td>
<td>• Endbackup.sql — Backs up the archive logs before and after the database files are created.</td>
</tr>
<tr>
<td></td>
<td>• Copy_DF.sql — Copies the raw data files to the backup directories.</td>
</tr>
<tr>
<td></td>
<td>• Copy_DF.bat — Copies the raw data files to the backup directories.</td>
</tr>
<tr>
<td></td>
<td>• Spfilepfile.sql — Creates a pfile from spfile.</td>
</tr>
<tr>
<td></td>
<td>• StoreDumpDest.sql — Creates OldDumpDest.sql to store old user_dump_dest.</td>
</tr>
<tr>
<td></td>
<td>• OldDumpDest.sql — Sets old user_dump_dest to backup folder.</td>
</tr>
<tr>
<td></td>
<td>• NewDumpDest.sql — Sets new user_dump_dest to backup folder.</td>
</tr>
<tr>
<td></td>
<td>• DumpControl.sql — Copies control file to trace.</td>
</tr>
</tbody>
</table>
The cs_cold_gen.bat script backs up database files, control files, redo logs, archive log files, the spfile, the Oracle password file, and raw data files to a specified backup drive. It also backs up the spfile to a pfile. As part of the backup, the archive log files are moved from their default locations to directories within the backup.

The database is shut down by the script before the backup begins and restarted once the backup is complete. Users cannot access the database while the backup is in process, and data acquired during the backup is buffered locally until the database is restarted. If the script is rerun to the same location, the existing backup is deleted and replaced by the new backup.

Using this script, you can back up to a directory that is subsequently backed up as part of the corporate backup strategy. You can use third-party backup applications with this script.

The following table lists the files created in the cold database backup script.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Sub-folder and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>database</td>
<td>Contains redo logs 1 to 4 and mirrored redo logs 1 to 4. Contains these ORA files:</td>
</tr>
<tr>
<td></td>
<td>• pfile</td>
</tr>
<tr>
<td></td>
<td>• pwdWAT11 (WAT11 is the default SID)</td>
</tr>
<tr>
<td></td>
<td>• SpfileWAT11</td>
</tr>
<tr>
<td></td>
<td>Contains these DBF files:</td>
</tr>
<tr>
<td></td>
<td>• INDEX0n (where n is 1 through 9)</td>
</tr>
<tr>
<td></td>
<td>• SYSAUX01</td>
</tr>
<tr>
<td></td>
<td>• SYSTEM01</td>
</tr>
<tr>
<td></td>
<td>• TEMP01</td>
</tr>
<tr>
<td></td>
<td>• UNDOTBS01</td>
</tr>
<tr>
<td></td>
<td>• USER0n (where n is 1 through 9)</td>
</tr>
<tr>
<td></td>
<td>The Controlfiles subfolder contains Control files 1 to 3.</td>
</tr>
<tr>
<td>projects</td>
<td>For each project in the database, there is a subdirectory containing the project’s raw data files.</td>
</tr>
</tbody>
</table>
### cs_cold_gen.bat database backup script:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Sub-folder and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>archive</td>
<td>Log Archive Dest 1 and Log Archive Dest 2 contain the archive log files.</td>
</tr>
<tr>
<td>backup</td>
<td>Backup files listed below.</td>
</tr>
<tr>
<td></td>
<td>- shutdown.sql — Immediately shuts down the database.</td>
</tr>
<tr>
<td></td>
<td>- startup.sql — Restarts the database.</td>
</tr>
<tr>
<td></td>
<td>- EmpowerCBU.sql — Builds the EmpowerCBU.bat file.</td>
</tr>
<tr>
<td></td>
<td>- EmpowerCBU.bat — Copies the database files.</td>
</tr>
<tr>
<td></td>
<td>- DBVerify.sql — Creates script to build DBVerify.bat.</td>
</tr>
<tr>
<td></td>
<td>- DBVerify.bat — Runs DBV on database files.</td>
</tr>
<tr>
<td></td>
<td>- ArcDir.sql — Generates a batch file that creates the list directories for each active archive log.</td>
</tr>
<tr>
<td></td>
<td>- ArcDir.bat — Creates directories of the backup directory to receive archive log files.</td>
</tr>
<tr>
<td></td>
<td>- Arc.sql — Generates a batch file for the movement of archive logs from each active archive log destination (1 through 10).</td>
</tr>
<tr>
<td></td>
<td>- Arc.bat — Copies the backup.</td>
</tr>
<tr>
<td></td>
<td>- Copy_DF.sql — Copies raw data files from all data shares.</td>
</tr>
<tr>
<td></td>
<td>- Copy_DF.bat — Copies the raw data files to the backup directories.</td>
</tr>
<tr>
<td></td>
<td>- Spfilepfile.sql — Creates a pfile from spfile.</td>
</tr>
<tr>
<td></td>
<td>- StoreDumpDest.sql — Creates OldDumpDest.sql to store old user_dump_dest.</td>
</tr>
<tr>
<td></td>
<td>- OldDumpDest.sql — Sets old user_dump_dest to backup folder.</td>
</tr>
<tr>
<td></td>
<td>- NewDumpDest.sql — Sets new user_dump_dest to backup folder.</td>
</tr>
<tr>
<td></td>
<td>- DumpControl.sql — Copies control file to trace.</td>
</tr>
<tr>
<td>database</td>
<td>Contains redo logs 1 to 4 and mirrored redo logs 1 to 4.</td>
</tr>
<tr>
<td></td>
<td>Contains these ORA files:</td>
</tr>
<tr>
<td></td>
<td>- pfile</td>
</tr>
<tr>
<td></td>
<td>- pwdWAT11</td>
</tr>
<tr>
<td></td>
<td>- SpfileWAT11</td>
</tr>
<tr>
<td></td>
<td>Contains these DBF files:</td>
</tr>
<tr>
<td></td>
<td>- INDEX0n (where n is 1 through 9)</td>
</tr>
<tr>
<td></td>
<td>- SYSAUX01</td>
</tr>
<tr>
<td></td>
<td>- SYSTEM01</td>
</tr>
<tr>
<td></td>
<td>- TEMP01</td>
</tr>
<tr>
<td></td>
<td>- UNDOTBS01</td>
</tr>
<tr>
<td></td>
<td>- USER0n (where n is 1 through 9)</td>
</tr>
<tr>
<td></td>
<td>The Controlfiles subfolder contains Control files 1 to 3.</td>
</tr>
<tr>
<td>projects</td>
<td>For each project in the database, there is a subdirectory containing the project’s raw data files.</td>
</tr>
</tbody>
</table>
5.1.2 Performing a database backup using a script

The cs_hot_gen.bat file performs a hot backup of the database and the cs_cold_gen.bat file performs a cold backup of the database to a hard disk drive. Whether the backup scripts are manually run from a command prompt or automatically run as a scheduled task, the command syntax requires seven variables.

**Backup variables:**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backupscript</td>
<td>&lt;installation drive&gt;:\Empower\Script\cs_hot_gen.bat</td>
</tr>
<tr>
<td>Backup_location</td>
<td>G:\Backup</td>
</tr>
<tr>
<td>Oracle SYSDBA username</td>
<td><strong>Default:</strong> SYS&lt;br&gt;<strong>Exception:</strong> When creating multiple database instances on a Windows-based Empower 3 FR3 Server, specify a connect string rather than a user name. In the following example, WAT11 is the next service name that exists on the server.&lt;br&gt;<strong>Example:</strong> connect string: sys@WAT11</td>
</tr>
<tr>
<td>Password (for Oracle SYSDBA user)</td>
<td>Oracle</td>
</tr>
<tr>
<td>Oracle_Home</td>
<td>&lt;installation drive&gt;:\Empower\Oracle\Oracle11g_4</td>
</tr>
<tr>
<td>Oracle_SID</td>
<td><strong>Default:</strong> WAT11</td>
</tr>
<tr>
<td>Exclude raw data</td>
<td>Yes / No&lt;br&gt;<strong>Tip:</strong> By default, raw data are included in the backup. To exclude raw data from the backup, select Yes.</td>
</tr>
</tbody>
</table>

The command syntax for using these script files is: backupscript backup_location OracleSYSDBA_username Password Oracle_home SID Exclude raw data.

**To perform a backup to a drive:**

1. Click Start > Run, enter CMD in the Run dialog box and click OK.<br>**Tip:** On Windows 2012, from Start, click the Search icon and type "CMD".
2. In the Command Prompt window, enter the command syntax for the type of backup you want to perform. For example:
   
   E:\Empower\Script\cs_hot_gen.bat G:\Backup sys oracle
   
   E:\Empower\oracle\oracle11g_4 wat11 no
   
   **Tip:** To perform a cold backup, substitute cs_cold_gen.bat for cs_hot_gen.bat.
3. Back up the Backup folder using Windows Backup, or a third-party backup application. The backup scripts overwrite the data daily or weekly. Use a third-
party software to have more than one backup available.

5.1.3  Manually capturing a current-state backup

This section describes how to manually back up the current Empower database and chromatographic raw data files.

Requirement: Even if the current database is not operational, copy all the Empower database files and all the chromatographic raw data files before attempting any restoration or recovery process.

Before copying the Empower database and chromatographic raw data files, you must stop the Oracle instance on the Empower server so that it does not change any files during the backup. This ensures that the files are copied correctly.

To capture a current state backup:

1. In the Search Box in the Start menu, type "Server Manager" and click Server Manager in the Program list.
   Tip: On Windows Server 2012, from Start, click Server Manager.
2. In the Server Manager tree, expand Configuration.
3. In the Configuration tree, select Services.
4. For WatersService and each service that begins with the name “Oracle” and that has a status of Started, do the following:
   - click the service name.
   - click Stop.
   - wait for the service to stop.
5. Stop the database.
6. Copy the following database files from the appropriate hard disk partition to a safe location that is not on the Empower server:

   \Empower\Oracle\Oracle11g_4\database\pwdWAT11.ora
   \Empower\Oracle\Oracle11g_4\database\SPFILEWAT11.ora
   \EmpowerDatabase\Oradata\WAT11\SYSTEM01.DBF
   \EmpowerDatabase\Oradata\WAT11\UNDOTBS01.DBF
   \EmpowerDatabase\Oradata\WAT11\SYSAUX01.DBF
   \EmpowerDatabase\Oradata\WAT11\USERS01.DBF
   \EmpowerDatabase\Oradata\WAT11\USERS02.DBF
   \EmpowerDatabase\Oradata\WAT11\USERS03.DBF
   \EmpowerDatabase\Oradata\WAT11\USERS04.DBF
   \EmpowerDatabase\Oradata\WAT11\USERS05.DBF
   \EmpowerDatabase\Oradata\WAT11\USERS06.DBF
Tip: Prior to the backup, the backup script checks the database to get the entire lists of files; however, you may have multiple file shares on multiple servers or you may have created new tablespace data files that reside in directories that are different than the ones listed above. Log on to Empower software, and click View > Manage Raw Data.
files to view all the configured file shares for your Empower system. You manually copy these database files to a safe location.

7. Once the files are copied, return to the Server Manager.
8. For each service that you stopped in step 4, perform these tasks:
   - click the service name.
   - click Start.
9. Restart the database.

**Alternative:** Restart the server, if you did not alter the startup type for each service. The startup type can be set to automatic [by default] or manual/disable (modified by user).

5.1.4 Using Windows Scheduler to schedule database backups

You can schedule hot and cold backups using the Windows Scheduler.

**Rule:** When creating multiple database instances on a Windows-based Empower 3 FR3 Server, backups must be scheduled on the database server.

**To schedule backups:**

1. In the Search Box in the Start menu, enter "Server Manager" and click Server Manager in the Program list.
   
   **Tip:** On Windows Server 2012, from Start, click Server Manager.
2. In the Server Manager tree, expand Configuration.
3. In the Configuration tree, select Task Scheduler.
4. In the Actions list, select Create Task.
5. On the General tab, specify a name and a description for the task.
6. Click Change User or Group, and then enter the username and password for the Windows user who has sufficient privileges to perform a scheduled task.
7. Click Run whether user is logged on or not.
8. Select the Triggers tab and click New.
9. Select the frequency and time of the backup, and then click OK.
10. Select the Actions tab and click New.
11. Verify that the action is set to Start a program.
12. Browse to the Empower\Script folder.
13. Select cs_cold_gen.bat or cs_hot_gen.bat, and then click Open.
14. In the Add arguments box, you must add the six backup parameters listed in the table titled "Backup variables:”, and then click OK twice.

**Example:** program drive\Empower\Script\cs_hot_gen.bat g:\backup sys oracle E:\empower\oracle\oracle11g_4 wat11 [yes/no]
Tip: A seventh, optional variable can be used to perform a backup of only the database files, omitting the copy of the raw data files. To perform a drive backup of the database files only, append the word “Yes” to the end of the backup command syntax in step 14.

Each time you run a backup script to the same location, the existing backup directories are deleted. You can schedule multiple backups to different destinations when you want to keep backups for a longer period of time.

Example: You can create seven weekly tasks with different names (such as MondayBackup, TuesdayBackup, and so on) and schedule each task to run on Restoring an Empower 3 FR3 data partition its designated day. In this way, you keep seven days’ worth of backups before the oldest is overwritten.

5.1.5 Testing backups

Recommendations:

- Periodically test your backup media sets to ensure that the backups are working correctly and according to your organization’s standard protocols for failure recovery.
- Create a test server with the same configuration as your actual server. Verify your backups by restoring them on the test server.

See also: Refer to the section "Backing up the Empower 3 FR3 database using scripts" to ensure that the proper scripts were dynamically created during the backup.

5.2 Recovering from a drive failure

Hard disk failure is a common cause of data loss. Sometimes you need to restore particular drives but other times you need to restore the entire database, depending on the type of failure.

Tip: If you have performed only hot backups, recovery is possible. This requires, however, a more involved recovery procedure that is beyond the scope of this guide. Contact your Waters Data Specialist for more information.

This section describes how to use the scripted backup sets to recover the Empower application (database and raw data files) if a problem occurs with the database, the supporting operating system, or the hardware on a particular hard drive partition.

Specifically, this section describes how to recover from these scenarios:

- a database drive failure using a cold backup
- an Empower software raw data drive failure
- an Empower program files disk failure
- a database and raw data drive failure
Tip: The recovery procedures described in this section assume that the Empower server is configured exactly as described (the application configured on four separate physical drives and partitions) in the Empower 3 Installation, Configuration, and Upgrade Guide. If you have performed a custom installation, you must modify the recovery procedures as needed. For example, if you selected a SID name other than WAT11, supply your SID in place of WAT11.

5.2.1 Recovering from database drive failure using a cold backup

Requirement: A cold backup restores your database to its state at the point of your last backup. To ensure that the raw data files are synchronized with the database, restore the raw data files that were backed up at the time of the cold backup.

Before you start the recovery process, perform these actions:

- Log in to the operating system as the administrator.
- If the database is running, shut it down as described in “Shutting down and starting up the Empower 3 FR3 database”.

To recover from database drive failure using a cold backup:

1. To ensure that you have matching database files, remove the entire contents of the database drive: \EmpowerDatabase\oradata\WAT11 tree before you restore the backup.
2. Create the EmpowerDatabase\oradata directory under the root of the database drive, and then create a subdirectory of the SID Name.
   
   Example: databasedrive:\EmpowerDatabase\oradata\WAT11.

3. From the cold backup database directory, copy all database data files (*.DBF) and REDO\n log files (where n is 1 to 4) to the databasedrive:\EmpowerDatabase\oradata\WAT11 directory.
4. From the Controlfile folder, copy Control01.CTL, to the databasedrive:\EmpowerDatabase\oradata\WAT11 directory.
5. Copy the contents of the rawdata drive: \WatersCDSMirrorDB\oradata\WAT11 to a neutral location.

   Tip: You can use these files if additional recovery is necessary. The additional recovery is not covered in this procedure.

6. Delete the contents of rawdata drive: \WatersCDSMirrorDB\oradata\WAT11.
7. From the cold backup database\controlfiles directory, copy Control02, and Control03 to the rawdata drive: \WatersCDSMirrorDB\oradata\WAT11.
8. From the cold backup database directory, copy REDO\n log files (where n is 1 to 4) to the rawdata drive: \WatersCDSMirrorDB\oradata\WAT11.
9. Restart the database by stopping and then restarting OracleServiceWAT11 or restart the server.
5.2.2 Recovering from an Empower software raw data drive failure

The Empower 3 FR3 software raw data disk contains the raw chromatographic files, the EmpowerArchive1DB directories, and often, the EmpowerMirrorDB directory (however, you may have configured your database differently). If the disk fails, you do not lose Empower 3 FR3 database information, because the Empower 3 FR3 database disk remains intact.

Because chromatographic files produced between the last backup and the time of a disk failure are not recoverable, you cannot review or otherwise use chromatograms acquired or their results during that time period; however, all methods created or edited, sample loading information, and results generated since the last backup are available.

5.2.2.1 Recovering from raw data drive failure

Before you start the recovery process, perform these actions:

- Log in to the operating system as the administrator.
- If the database is running, shut it down as described in “Shutting down and starting up the Empower 3 FR3 database”.

**Tip:** In this procedure, substitute your SID for WAT11 if your SID is different. Keep in mind that the installed software may reside on different drives than listed in the recovery procedure outlined below.

**To recover from a raw data drive failure:**

1. Create the Projects directory on the raw data drive:

   rawdatadrive:\Empower\Projects.

2. From the backup projects directory, copy all projects’ folders to the rawdata drive:\Empower\Projects directory.

   **Tip:** Your configuration may consist of multiple shares with raw data.

3. Share the Projects directory with the share name Waters_Projects$ and set the appropriate level of security as described in the Empower 3 Installation, Configuration, and Upgrade Guide.

4. From the database drive:\EmpowerDatabase\oradata\WAT11 directory, copy Control01 to the rawdata drive:\WatersCDSMirrorDB\oradata\WAT11.

5. In the rawdata drive:\WatersCDSMirrorDB\oradata\WAT11 directory, rename Control01.CTL to Control02.CTL.

6. From the database drive:\EmpowerDatabase\oradata\WAT11 directory, copy Control01 to the rawdata drive:\WatersCDSMirrorDB\oradata\WAT11.

7. In the rawdata drive:\WatersCDSMirrorDB\oradata\WAT11 directory, rename Control01.CTL to Control03.CTL.
8. From the database drive: `\EmpowerDatabase\oradata\WAT11` directory, copy REDO0n log files (where n is 1 to 4) to the raw data drive: `\WatersCDSMirrorDB\oradata\WAT11`.

9. In the raw data drive: `\WatersCDSMirrorDB\oradata\WAT11` directory, rename REDO0n.RDO log files to REDO2n.RDO (where n is 1 to 4).

10. Create the archive log directory raw data drive:

    `\WatersCDSArchive1DB`.

11. From the program drive: `\WatersCDSArchive2DB` directory, copy all contents of the directory to raw data drive: `\WatersCDSArchive1DB`.

12. Restart your database by stopping and then starting `OracleServiceWAT11` or restart the server.

**Tip:** This procedure assumes a single raw data drive or share. Empower software supports multiple raw data shares.

### 5.2.3 Recovering from an Empower program files disk failure

The Empower 3 FR3 program files disk contains the Empower program file and the Empower\Script directory. The Oracle program files disk contains the Oracle directory `oracle_home`, including the Oracle password file (`pwdWATn.ora`) and the `WatersCDSArchive2DB` directory containing one set of archive log files. Recovering these disks involves reinstalling Empower and Oracle.

**Tip:** Empower software and Oracle can both occupy the same program disk, but can also exist on separate program disks.

In the case of partial disk failure (such as bad data sectors), where all archive (*.arc) files can be saved from the disk, back up the database drive immediately. You can then copy the archive files to a tape or network drive before the disk is repaired. This allows restoration of the database to the state at the time of failure.

**Recommendation:** Back up all other drives, in case any files are inadvertently deleted or overwritten. Ensure that the target directories have sufficient disk space to copy the files.

#### 5.2.3.1 Recovering from a program drive failure

The best option is to restore a disk image backup of the entire drive, if available. If a disk image backup of the program files disk is not available, or your backup does not include the latest changes, reinstall Empower 3 FR3 and Oracle as follows.

**To recover from an Empower program drive failure:**

1. Manually back up the contents of the database drive: `\EmpowerDatabase\oradata\WAT11` directory to a safe location, such as a network drive, and then delete the database drive: `\EmpowerDatabase` directory.
2. Manually back up the contents of the rawdata drive:\Empower\Projects directory to a safe location, such as a network drive, and then delete the rawdata drive:\Empower\Projects directory.

3. Manually back up the rawdata drive:\WatersCDSArchive1DB and rawdata drive:\WatersCDSMirrorDB directories to a safe location, and then delete the directories.

4. Reimage the operating system drive to the last restore point before Empower was installed.

5. Reinstall Empower from the Empower 3 FR3 DVD as described in the Empower 3 Installation, Configuration, and Upgrade Guide to the same location that it was originally installed and use the same SID and global database name.

6. Access Services and set the Startup Type for the following services to Disabled:
   - OracleServiceWAT11
   - OracleEmpower11g_4TNSListener
   - WatersService

7. Restart the server.

8. Replace the contents of the database drive: \EmpowerDatabase\oradata\WAT11 with the database files backed up in the cold backup, including the control01.ctl file.

9. Replace the contents of the program drive:\WatersCDSArchive2DB directory with the contents of archive\LOG_ARCHIVE_DEST_1, from the cold backup.

   **Tip:** Use these same files to replace the contents of rawdata drive:\WatersCDSArchive1DB.

10. Replace the contents of the rawdata drive:\Empower\Projects directory with the project files from the cold backup.

11. Replace the Control02, Control03, Redo21, Redo22, Redo23, and Redo24 files in the rawdata drive:\WatersCDSMirrorDB directory with the Control and Redo files from the cold backup.

12. Copy the tnsnames.ora file that was manually backed up and paste it into the program drive:\Empower\Oracle\Oracle11g_4\network\admin and Empower\Oracle\Oracle11gClient directories.

13. Replace the program drive:\Empower\Oracle\Oracle11g_4\network\admin\listener.ora file with the listener.ora file from the manual backup.

14. Share the rawdata drive:\Empower\Projects directory with the share name Waters_Projects$, and then set the appropriate level of security as specified in the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.

15. Access Services and set the Startup Type for the following services to Automatic:
   - OracleServiceSID_Name
   - OracleEmpower11g_4TNSListener
   - WatersService

16. Restart the server.
5.2.4 Recovering from a database and raw data drive failure

If both the Empower 3 FR3 database drive and the Empower 3 FR3 raw data drive fail, the mirrored control files become unrecoverable. This situation requires that you restore using a cold backup.

To recover from a database and raw data drive failure:
1. Follow the steps in "Recovering from database drive failure using a cold backup".
2. Follow the steps in "Recovering from an Empower software raw data drive failure".

5.3 Restoring the Empower 3 FR3 database

This restore and recovery process is based on replacing the existing Empower database with the copy of the database from the last known good database backup set created while the database was closed. This type of backup set is created during the execution of the CS_Cold_Gen.bat backup script. All user activity and database transaction activity that occurred after the time of the cold backup set remain unavailable.

When you perform a restore either of database or raw data files, consider the synchronization between the two sets of files.

Notice: During a catastrophic failure, ensure your last database backup is secure by storing it in a secure location. To ensure that the last database is not overwritten, rename the database backup directory. Make sure that you have a copy of the backup on a server or a storage unit separate from the damaged server.

5.3.1 Recovering the last known good cold database backup

This procedure entails stopping the database, restoring the files in the backup set to the appropriate server hard disk locations (replacing the existing files), and then starting the database. Because this process is based on restoring a cold database backup, there is no need for manual database recovery. This procedure describes only the process of database restoration and recovery. You must manually restore the associated chromatographic raw data.

Before replacing the files that support the server's database with files from the backup location, you must set the Oracle instance on the Empower server so that it does not automatically start when the server is powered-on. This ensures that the files are restored correctly.
To recover to the time of the last known good cold database backup:

1. On the computer desktop, right-click My Computer and select Manage.
   **Tip:** To access the Computer Management dialog in Windows Server 2012, click Server Manager > Manage > Computer Management.
2. In the Services and Application group, click the Services folder.
3. For WaterService and each service that begins with the name “Oracle”:
   - double-click the service name.
   - click the General tab.
   - in the Startup type box, select Disabled.
   - click OK.
4. Close all applications.
5. Reboot the server.
6. Copy the files listed below from the cold backup set’s Database folder to the noted destination locations on the appropriate hard disk partition.

Database storage information:

<table>
<thead>
<tr>
<th>File</th>
<th>Destination location</th>
</tr>
</thead>
<tbody>
<tr>
<td>pwdWAT11.ora</td>
<td>Empower\Oracle\Oracle11g\database</td>
</tr>
<tr>
<td>SPFILEWAT11.ora</td>
<td></td>
</tr>
<tr>
<td>controlfiles\control02.ctl</td>
<td>WatersCDSMirrorDB\Oradata\WAT11</td>
</tr>
<tr>
<td>controlfiles\control03.ctl</td>
<td></td>
</tr>
<tr>
<td>redo21.ora</td>
<td></td>
</tr>
<tr>
<td>redo22.ora</td>
<td></td>
</tr>
<tr>
<td>redo23.ora</td>
<td></td>
</tr>
<tr>
<td>redo24.ora</td>
<td></td>
</tr>
<tr>
<td>File</td>
<td>Destination location</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>control01.ctl</td>
<td>\EmpowerDatabase\Oradata\WAT11</td>
</tr>
<tr>
<td>redo01.rdo</td>
<td></td>
</tr>
<tr>
<td>redo02.rdo</td>
<td></td>
</tr>
<tr>
<td>redo03.rdo</td>
<td></td>
</tr>
<tr>
<td>redo04.rdo</td>
<td></td>
</tr>
<tr>
<td>SYSTEM01.dbf</td>
<td></td>
</tr>
<tr>
<td>UNDOTBS01.dbf</td>
<td></td>
</tr>
<tr>
<td>TEMP01.dbf</td>
<td></td>
</tr>
<tr>
<td>SYSAUX01.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX01.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX02.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX03.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX04.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX05.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX06.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX07.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX08.dbf</td>
<td></td>
</tr>
<tr>
<td>INDEX09.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS01.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS02.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS03.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS04.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS05.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS06.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS07.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS08.dbf</td>
<td></td>
</tr>
<tr>
<td>USERS09.dbf</td>
<td></td>
</tr>
</tbody>
</table>

**Tip:** The table describes the typical locations for these files. The locations can vary according to a particular installation and also to later configuration actions like adding additional raw data shares or additional tablespace data files.

After the files are restored, set the Oracle instance on the Empower server to start automatically when the server is rebooted. This ensures that the current database, which is from a cold backup set, starts automatically and is available to support the Empower application.

**To enable the Windows services for Oracle to start automatically:**

1. On the computer desktop, right-click My Computer and select Manage.
   
   **Tip:** To access the Computer Management dialog in Windows Server 2012, click Server Manager > Manage > Computer Management.
2. In the Services and Application group, click the Services folder.
3. For WatersService and each service that begins with the name “Oracle”:
   - double-click the service name.
   - click the General tab.
   - in the Startup type box, select Automatic, and then click OK.
4. Close all applications.
5. Stop, and then restart, the database instance.
6 Troubleshooting

This chapter provides guidelines for isolating and correcting system-level problems that can occur with the Empower 3 FR3 Enterprise or Workgroup system. It describes possible symptoms and corrective actions for both hardware and software problems.

For complete information on reporting shipping damages and submitting claims, see Waters Licenses, Warranties, and Support Services on the Empower 3 FR3 documentation media.

6.1 Additional help

For additional Empower 3 FR3 system troubleshooting help, consult the following documentation:

- Empower 3 Feature Release 3 online Help
- Windows Help
- Hardware documentation shipped with your system hardware
- Operator’s guides for detectors, pumps, autosamplers, and other components of the chromatography system
- Empower 3 Feature Release 3 Release Notes
- www.Waters.com
- Waters Technical Service

If the corrective actions suggested here fail to correct a problem, consult “Reporting problems” and then contact Waters for assistance.

Customers in the USA and Canada can report the problems to Waters Technical Service (800 252-4752). Others can phone their local Waters subsidiary or Waters corporate headquarters in Milford, Massachusetts (USA), or visit www.waters.com.

6.2 Isolating problems

Isolating the problem is the first step in troubleshooting. Because the necessary procedure depends on system type, this chapter provides general instructions for isolating a problem.

Keep in mind the following recommendations when attempting to isolate a problem:

- Develop a systematic troubleshooting strategy.
- Check simple things first, such as cable connections and privileges.
- Try to reproduce a symptom and note all steps leading up to the problem.
• Make only one change at a time to identify the cause of a problem.
• Software problems in the Empower 3 FR3 software application can generate an Empower error message. If no message appears, or if you cannot log in, the problem can be a setup problem.
• For an instrument control problem, disconnect the device in question from the acquisition server, and if possible control the device from its front panel. If the device does not respond as expected when programmed from its front panel, the problem is within the instrument, not the Empower 3 FR3 system.
• Check the Empower 3 FR3 Message Center for errors.
• Check the operating system’s Event Viewer for errors.

6.2.0.1 Recording problems

Record all system problems and troubleshooting activities in the System Problem Log.

6.3 Reporting problems

Before you contact Waters technical assistance, make sure you have adequately investigated the problem. If the corrective actions listed in this chapter do not solve the problem, collect all your troubleshooting information, the System Problem log, and relevant technical manuals, and then contact Waters.

When you contact Waters, be ready to offer the following information:

• Software support plan number
• A description of the symptoms
• An accurate assessment of the problem’s severity; for example, system down, server down, PC down, PC client not connecting to server, printer printing unusual characters, or occasional malfunction
• When the problem started; whether it is reproducible, intermittent, or constant; and whether it is data-related or account-related
• The specific sequence of events leading to the problem
• Whether the system has been recently modified, new hardware or software has been installed, or maintenance has been performed
• Actions you took to correct the problem
• Version information for:
  • Empower 3 FR3 software (obtain the build number and any service or feature releases from any Help > About dialog box)
  • Windows operating system software (use the System applet in Control Panel for the software version)
  • Waters HPLC devices and instruments (see the Empower 3 FR3 installation log or use the Verify Files utility to obtain firmware versions)
  • Basic configurations and serial numbers of the hardware components involved
  • Hard-copy examples of printouts
  • User manuals for the components
Be prepared to perform these tasks:

- Swap cables, if you have not already tested cables
- E-mail or fax hard-copy documentation of the problem

**Recommendation:** Be sure to call from a location that is close to the system in question. Your Waters Technical Support representative can help you more effectively if you have access to the system while you are on the telephone.

### 6.4 Buffering and data recovery problems

Empower 3 FR3 software provides data buffering and recovery to safeguard your acquired data in the event of a server or network failure. If the LAC/E\textsuperscript{32} acquisition server or the acquisition client loses its connection to the Empower 3 FR3 database or to the file server that is storing the project’s raw data, Empower 3 FR3 stores the acquired data temporarily on the LAC/E\textsuperscript{32} acquisition server or acquisition client’s hard drive, on the drive where the Empower 3 FR3 program files are installed. Once the network connection has been restored, the LAC/E\textsuperscript{32} acquisition server or acquisition client resumes sending the data to the appropriate server or servers.

**Tip:** Database information (sample identifiers, method information, results, and so on) is stored in the Empower 3 FR3 database on the Empower 3 FR3 server. By default, chromatographic raw data are stored in the rawdata-drive:\Empower\Projects directory on the Empower 3 FR3 server.

You can change the location of raw data using the Manage Raw Data Files capability to another computer as long as the Waters Service is present. Hence, data are buffered when the Empower 3 FR3 database or the computer storing the project raw data (\servername\Waters_Projects\, by default) is not available on the network for any reason.

**See also:** Managing raw data files

#### 6.4.1 Reconnecting while buffering

When buffering is taking place, the chromatographic data currently being acquired are stored in the \Empower\InstrumentServer directory on the acquisition server. When this occurs, the acquisition server attempts to reconnect to the appropriate server(s) after each injection. If the acquisition server reconnects, then the buffered injection(s) data is copied over the network to the appropriate location(s). The software then deletes the raw data files on the acquisition server’s hard drive, buffering stops, and normal acquisition continues.

The appropriate network connection(s) must be intact before you can acquire a sample set. Immediately after acquisition of a sample set begins, the Empower 3 FR3 software downloads all methods required to complete data acquisition to the acquisition server. This downloading sequence must end before acquisition can begin, and is necessary if subsequent buffering is required.
If data are still being buffered after acquisition of a sample set or a single injection is complete, the acquisition server checks the appropriate network connection every 10 minutes (approximately) until the connection is restored, at which time the data are copied to the appropriate location and then deleted from the acquisition server.

**Tip:** The Empower 3 FR3 software also buffers data from all queued sample sets, if necessary.

### 6.4.2 Continuing acquisition while buffering

When buffering is taking place, acquisition continues for the remainder of the queued sample sets. While buffering is occurring:

- Acquisition continues in Run Only, Continue on Fault mode.
- The real-time plot does not always appear in Run Samples.
- The buffered data cannot be seen in the Review window.
- An “x” appears on the disk icon in the Run Samples window. (This icon appears in the status bar in the lower right-hand corner, next to the clock.)

When the network connection is restored, and normal acquisition resumes, these conditions no longer apply; however acquisition continues in Run Only mode.

### 6.5 Disconnect dead connections

Sometimes you receive the "server busy" message when you try to move project data or manually archive projects, because the LAC/E\textsuperscript{32} acquisition server is running with no active connections. This happens when the LAC/E\textsuperscript{32} acquisition server is turned off unexpectedly, as with a power failure.

Look at the Projects tab in System Monitor to determine whether processes need to be disconnected. You can also automatically check for dead connections by editing the sqlnet.ora file.

**To automatically disconnect dead connections:**

1. Log in to the database server.
2. In Notepad, open the sqlnet.ora file.
3. Enter the following commands:

   sqlnet.authentication_services = (NTS)
   sqlnet.expire_time=X

   where X equals the number of minutes after which you want the database to check for dead connections, for example, every 10 minutes.

**Tip:** If you set this parameter too small, such as 2 minutes, database performance is sometimes slowed.
4. Reboot the database server.
5. Check System Monitor to ensure all processes are clear.

## 6.6 Software problems

The following table includes symptoms, possible causes, and suggested corrective actions for general software problems.

**Troubleshooting issues:**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>System performance degraded.</td>
<td>Not enough free disk space.</td>
<td>In Windows Explorer, view the properties of the drives used to check free disk space. Archive or delete files if disk space is low (see “Managing the server disk space”).</td>
</tr>
<tr>
<td></td>
<td>Not enough contiguous free disk space (disk fragmentation).</td>
<td>Defragment the drive: Perform a backup and restore all hard disks or you can use the OS disk defragmenter by clicking Start &gt; All Programs &gt; Accessories &gt; System Tools &gt; Disk Defragmenter.</td>
</tr>
<tr>
<td>Errors when checking disk status.</td>
<td>Network is down. Services are not running. Firewall settings were modified.</td>
<td>See the Windows 7, Windows 8.1, Windows Server 2008 R2, Windows Server 2012 R2 documentation.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible cause</td>
<td>Corrective action</td>
</tr>
<tr>
<td>-------------------------------------------------------------------</td>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client cannot connect to the database.</td>
<td>Server is down.</td>
<td>Restart the server.</td>
</tr>
</tbody>
</table>
|                                                                  | Listener is not running.              | Restart Listener.  
To restart the Listener:  
1. Select Start > All Programs > Empower > Waters Net Configuration Assistant.  
Alternative: Click Start, and type Waters Net Configuration Assistant.  
From Empower Personal: Click [program drive]:\Empower\Bin\WatersNetConfig application.  
Tip: In Windows Server 2012, from Start > click the down arrow (↓) to display the Apps page > point to Empower > select Waters Net Configuration Assistant.  
2. From Waters Net Configuration Assistant, click Configuration > Listener Configuration.  
3. To start the Listener, click Start.  
Tip: You can also Stop the Listener and obtain the Listener status. |
| Client configuration problem.                                     | Verify that the entries in the client’s tnsnames.ora file are correct or that the TNS_ADMIN variable is pointing to the correct share. |
| Network problem.                                                   | Ensure that the network cabling is properly connected.   
Use the Windows 7, Windows 8.1 or Windows Server 2008 R2, Windows Server 2012 TCP/IP utility on the client to ping the server.   
When routing, ensure that the default gateway is set properly.     |
| Client cannot connect to Run Samples on the LAC/E acquisition server. | User does not have appropriate privileges.  
From the client, ensure that user is logged in to the correct domain relationship. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When attempting to process data using Run and Report or background processing, no results are created.</td>
<td>The Empower path cannot be located.</td>
<td>Ensure that the Empower path is listed before other paths in the operating system’s path environment variable.</td>
</tr>
<tr>
<td></td>
<td>The TNS_ADMIN variable references a Win2008 R2 or Win2012 R2 database server that has not had its security settings properly configured.</td>
<td>Refer to Chapter 4 in the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.</td>
</tr>
<tr>
<td>An error stating “No COM connection” occurs when attempting to connect to an acquisition server.</td>
<td>The Waters Service is not running or the acquisition server is not in a domain relationship.</td>
<td>Start the Waters Service (if the Waters Service is not on the list of services in the operating system, call Waters Technical Support) or enable two one-way trusts between the domains.</td>
</tr>
<tr>
<td>Client in another domain cannot access Empower resources.</td>
<td>Domain trusts are not set up.</td>
<td>Ensure there is a two-way trust between domains, or create an account in the Empower domain specifically for that user.</td>
</tr>
<tr>
<td>Run not starting, database fetch error, or connect error.</td>
<td>Incorrect database alias for LAC/E&lt;sup&gt;32&lt;/sup&gt; acquisition server.</td>
<td>Check the database alias on the LAC/E&lt;sup&gt;32&lt;/sup&gt; or acquisition client for the database you are trying to connect to.</td>
</tr>
<tr>
<td>LAC/E&lt;sup&gt;32&lt;/sup&gt; began acquisition in buffering mode.</td>
<td>Mismatch of database service names between clients and LAC/E&lt;sup&gt;32&lt;/sup&gt; acquisition server.</td>
<td>Standardize tnsnames.ora file.</td>
</tr>
<tr>
<td>Client cannot see chromatograms or create and/or delete projects.</td>
<td>User is not logged in to the domain or permissions are not correct in the raw data share.</td>
<td>See the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.</td>
</tr>
<tr>
<td></td>
<td>Firewall exceptions not set properly.</td>
<td>See the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.</td>
</tr>
</tbody>
</table>

### 6.6.1 ACQUITY UPLC problems

For ACQUITY UPLC systems controlled with Empower 3 FR3, you can use Connections INSIGHT iHelp service, which offers on-demand help and support. The iHelp Request service automatically and securely captures a snapshot of your system’s profile with your question and sends the information directly to the Waters Global Technical support team. The support team then contacts you to help resolve your system issue.
You must install Connections INSIGHT software on the Empower 3 FR3 computer that is connected to the ACQUITY UPLC system and the computer where you control the ACQUITY UPLC system. Connections INSIGHT software requires an active Internet connection, either directly or through a firewall or proxy server.

See also: Connections INSIGHT Quick Start Guide for information on installing Connections INSIGHT software and Connections INSIGHT User’s Guide for information on using Connections INSIGHT software.

To submit an iHelp request:

1. Open the Connections INSIGHT software tray application, and select the iHelp tab.
2. In the iHelp Request dialog box, describe the problem or question, and provide your contact information.
3. If necessary, you can select data to include with your inquiry, or upload files such as a plot or chromatogram.

   Tip: Select Method and Directory to provide Waters with the methods used in the project last downloaded to the instrument or device. Doing so does not send chromatographic data to Waters. Nevertheless, this function is useful for troubleshooting software related issues.

4. Click Submit iHelp Request.

   Result: The service profile is created and sent to the Connections INSIGHT Enterprise Server. The file uploading process triggers an e-mail alert to the Waters Expert Center, which contacts you after reviewing the service profile.

6.7 Hardware problems

The troubleshooting tables in this section include symptoms, possible causes, and suggested corrective actions for problems with the following hardware components:

- Acquisition
- Printer
- Citrix

If the troubleshooting procedures in this section do not correct the problem with your system, see the manual shipped with the hardware and perform the recommended test and diagnostic procedures. If you discover a problem that requires repair of a component, check your maintenance agreement for the appropriate support organization to contact.

See the Empower 3 Feature Release 3 online Help for additional troubleshooting information, maintenance procedures, and status messages.
## Troubleshooting the LAC/E32:

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAC/E32 module power LEDs do not glow.</td>
<td>LAC/E32 module not plugged in to power outlet.</td>
<td>Connect the LAC/E32 module to the power outlet.</td>
</tr>
<tr>
<td></td>
<td>LAC/E32 module power not on.</td>
<td>Power-on the LAC/E32 module.</td>
</tr>
<tr>
<td></td>
<td>No power at outlet.</td>
<td>Check power at the outlet.</td>
</tr>
<tr>
<td></td>
<td>Hardware failure.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td>Failure to connect to LAC/E32 Acquisition Server over the network or through Empower software.</td>
<td>Incorrect LAC/E32 acquisition server configuration.</td>
<td>Check that the LAC/E32 acquisition server is in the correct network domain.</td>
</tr>
<tr>
<td></td>
<td>Network card not functioning.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td></td>
<td>busLAC/E hardware error.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td></td>
<td>Firewall exceptions not set properly.</td>
<td>See the latest version of the Empower 3 Installation, Configuration, and Upgrade Guide.</td>
</tr>
<tr>
<td>Data files not available for review because data files were not copied to database server.</td>
<td>Waters Service not running on LAC/E32 acquisition server or acquisition client.</td>
<td>Set Waters Service Startup to Automatic (Delayed Start), and then reboot the LAC/E32 acquisition server or acquisition client.</td>
</tr>
<tr>
<td></td>
<td>Waters Service not running on database server.</td>
<td>Set Waters Service Startup to Automatic (Delayed Start), and then start the service; wait up to 10 minutes for data file upload.</td>
</tr>
<tr>
<td></td>
<td>General networking failure.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible cause</td>
<td>Corrective action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cannot see print resources from Run Samples.</td>
<td>Print queues not registered.</td>
<td>Register print queues on the LAC/E32 acquisition server or acquisition client by selecting Start &gt; All Programs &gt; Empower &gt; Register Empower Node Printers (Windows 7 systems). You must be logged in to the operating system as an administrator. You can perform this procedure remotely using Windows Remote Desktop Connection.</td>
</tr>
<tr>
<td>Could not recover all sample set data when performing a run on LAC/E32 acquisition server.</td>
<td>Network cable was removed, causing data buffering.</td>
<td>The TNS_ADMIN variable inhibits recovery after removal of a network cable. Use a local tnsanmes file, and then upload sample set data.</td>
</tr>
</tbody>
</table>

**Troubleshooting the printer:**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No response when you power-on printer.</td>
<td>Power cord not connected.</td>
<td>Securely connect the power cord to the printer and wall outlet.</td>
</tr>
<tr>
<td>No power at outlet.</td>
<td>Check power at the outlet.</td>
<td></td>
</tr>
<tr>
<td>Hardware failure.</td>
<td>Call Waters Technical Service.</td>
<td></td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible cause</td>
<td>Corrective action</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Printer does not print.</td>
<td>Data or method problem.</td>
<td>Preview the file to screen. If the file previews to the screen, troubleshoot the printer. If the file does not preview to the screen, the problem is within Empower and could be data-related or method-related.</td>
</tr>
<tr>
<td>No batch or run and report printing.</td>
<td></td>
<td>Register the Empower Node printers as a local or domain Admin.</td>
</tr>
<tr>
<td>No batch or run and report printing.</td>
<td></td>
<td>Check printer privileges on the printer server. Set permissions to Everyone.</td>
</tr>
<tr>
<td>Printer not powered-on.</td>
<td>Power-on the printer.</td>
<td></td>
</tr>
<tr>
<td>Printer not online.</td>
<td>Check the Ready LED on the printer. If it is not lit, consult the user guide that accompanies the printer.</td>
<td></td>
</tr>
<tr>
<td>Paper jammed.</td>
<td>Reload the paper. Make sure paper is threaded properly and/or the correct paper is loaded.</td>
<td></td>
</tr>
<tr>
<td>Print queues not running properly.</td>
<td></td>
<td>Check printer settings and properties. Use the Index tab of the Windows Help to search for printer topics. If a queue is stopped, stalled, or paused, restart the printer.</td>
</tr>
<tr>
<td>Printer not connected to system.</td>
<td></td>
<td>Check the cable connections to the computer or network.</td>
</tr>
<tr>
<td>Wrong printer specified.</td>
<td>Specify the correct printer.</td>
<td></td>
</tr>
<tr>
<td>Printer error.</td>
<td>Check the printer display for an error. See the owner’s guide to troubleshoot the error.</td>
<td></td>
</tr>
</tbody>
</table>
## Troubleshooting Citrix problems:

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When using Citrix Web interface to access Empower 3 FR3 software as a browser-enabled application, the Empower Login window launches full screen and sometimes fails if a user clicks the Advance button.</td>
<td>The appearance of the Citrix Web interface is set to maximize windows when they open.</td>
<td>In the Citrix Management console, access the Application Appearance table and clear the Maximize application on startup check box.</td>
</tr>
<tr>
<td>When using Citrix Web interface to access Empower 3 FR3 software as a browser-enabled application, a user cannot select the System Default Interface.</td>
<td></td>
<td>In the Citrix Management console, access the Application Appearance table and clear the Maximize application on the startup check box.</td>
</tr>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible cause</strong></td>
<td><strong>Corrective action</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>When using Citrix Web interface to access Empower 3 FR3 software, local drives and directories are not accessible as options when you perform tasks that enumerate the local drives, such as backing up and restoring a project.</td>
<td>This behavior is related to the response given to the File Security - Citrix online plug-in dialog box that appears the first time a user performs a task that requires enumeration of the local drives; for example, when projects are backed up or restored or when methods or reports are exported. If at any time “No Access” was selected in this dialog box, Citrix Web interface users cannot access the client local drives on that workstation.</td>
<td>Follow the instructions in “Citrix Online Plug-in 12.0 Ignores Webica.ini Settings” (Document ID CTX124921) in the Citrix Knowledge Center (<a href="http://support.citrix.com">http://support.citrix.com</a>).</td>
</tr>
<tr>
<td>When restoring a project from a Citrix client, one or more of these behaviors is observed:</td>
<td>Projects to be restored are local on the Citrix client.</td>
<td>When restoring from a Citrix client drive, ensure the client is part of a domain that has some trust relationship with the Citrix server and is logged into that domain. The restore operation can fail if the client and the server reside in separate domains with no trust relationship.</td>
</tr>
<tr>
<td>- Restore wizard response is delayed, and the window status is sometimes &quot;Not Responding&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Project hierarchy is not restored</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Project restoration fails</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 6.8 Troubleshooting procedures

#### 6.8.1 Evaluating Windows error messages

System messages from the Windows operating system and its various utilities share a similar format. Take note of the information in the message.

**Tip:** Capture an image of the error message using the Windows Print Screen function or a screen capture utility.
For additional information, click the ? button, the Help button, or the F1 key.

Click OK after you read the message.

**Tip:** Windows 7 operating system provides more information within the error message dialog box.

For more information about Windows operating system and utility error messages, see the Windows 7 Help, Windows 2008 R2 Help, or the Microsoft Web site.

### 6.8.2 Evaluating Empower 3 FR3 software error messages

Empower 3 FR3 software application status and error messages appear in the Message Center on the client. For details on the Message Center error messages, see the Empower 3 FR3 online Help.

If you need to call Technical Support about an error message, note the particular error and document the steps required to re-create the error before contacting Waters.

#### 6.8.2.1 Evaluating Oracle errors

For information about Oracle system and utility error messages, see the Oracle Database 11g Release 4 (11.2.0.4) for Microsoft Windows X64 (64-bit) Documentation media.

**Notice:** If you create or modify database objects in response to Oracle error messages you can negatively affect Empower 3 FR3 software performance and sometimes need to re-validate the software. Contact your Waters Data Specialist before implementing any database changes.

If you need to call Technical Support about an error message, note the particular error and document the steps required to re-create the error before contacting Waters.
This appendix provides sample forms for logging important system information.

### A.1 Database initialization parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Database instance</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle SID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Database Domain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Application Drive</td>
<td></td>
<td>There is only one copy of Oracle program files.</td>
</tr>
<tr>
<td>Empower Oracle Database</td>
<td></td>
<td>Called DB_DIRECTORY in Oracle Database Configuration Assistant (DBCA).</td>
</tr>
<tr>
<td>Empower Projects</td>
<td></td>
<td>You must create unique Share Names for each instance.</td>
</tr>
<tr>
<td>Empower Program Files</td>
<td></td>
<td>There is only one copy of the Empower 3 Program files.</td>
</tr>
<tr>
<td>Mirrored Directory</td>
<td></td>
<td>Called DB_MIRROR in DBCA.</td>
</tr>
<tr>
<td>First Archive Directory</td>
<td></td>
<td>Called DB_ARCHIVE in DBCA.</td>
</tr>
<tr>
<td>Second Archive Directory</td>
<td></td>
<td>Called DB_ARCHIVE2 in DBCA.</td>
</tr>
<tr>
<td>Memory allocation</td>
<td></td>
<td>Step 8 of 9 in DBCA. Confirm that the memory allocation is divided sufficiently for each instance. Be sure to reserve enough memory for the operating system.</td>
</tr>
</tbody>
</table>
| Character Set              |                   | Must be WE8ISO8559P1. Tip: To confirm that the database uses the correct character set, open the alert log file and search for the line “Database Characterset is WE8ISO8559P1”.

February 22, 2016, 715005082 Rev. A
Page 73
A.2 Database storage information (Control files)

Tip: If you need additional space, attach suitable documentation.

Control files:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Database instance</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control File 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control File 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control File 3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A.3 Database storage information (Tablespace)

Tip: If you need additional space, attach suitable documentation.

Database storage information:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Database instance</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index_Data Tablespace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYSAUX Tablespace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYSTEM Tablespace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEMPORARY_DATA Tablespace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UNDOTBS1 Tablespace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USER_DATA Tablespace</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A.4 Data file information

Record the tablespace name, and then record the path and size for each file.

Data file log:

<table>
<thead>
<tr>
<th>Tablespace name</th>
<th>Database instance</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### A.5 Data file information (Redo_logs)

**Redo logs:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Database instance</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redo Log Group 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redo Log Group 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redo Log Group 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redo Log Group 4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### A.6 Disk space usage log

**Disk space usage log:**

<table>
<thead>
<tr>
<th>Date/initials</th>
<th>Drive</th>
<th>Free disk space</th>
<th>Date/initials</th>
<th>Drive</th>
<th>Free disk space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date/initials</td>
<td>Drive</td>
<td>Free disk space</td>
<td>Date/initials</td>
<td>Drive</td>
<td>Free disk space</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td>-----------------</td>
<td>--------------</td>
<td>-------</td>
<td>-----------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### A.7 Database backup log

Database backup log:

<table>
<thead>
<tr>
<th>Date/initials</th>
<th>Database disk</th>
<th>Storage media description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

February 22, 2016, 715005082 Rev. A

Page 76
### A.8 Full disk backup log

Full disk backup log:

<table>
<thead>
<tr>
<th>Date/initials</th>
<th>Drive volume name</th>
<th>Media label</th>
<th>Backup set name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### A.9 System service log

System service log:

<table>
<thead>
<tr>
<th>Date/initials</th>
<th>Service performed</th>
<th>Service provider</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### A.10 System problem log

**System problem log:**

<table>
<thead>
<tr>
<th>Date/initials</th>
<th>Problem description</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A.11 Hardware service information sheet

Hardware technical support/repair terms:
Name of service company:
Address:
Telephone number:
Contact person:
Service access number:
Service contract expiration date:

A.12 Software service information sheet

Software technical support/repair terms:
Name of service company:
Address:
Telephone number:
Contact person:
Service access number:
Service contract expiration date: